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I. Introduction

ArcGIS is a software package in the Graphical User Interface design for processing

spatial data (Geographic Information System). Through this software, can perform

display (visualization data), explore, query, and analysis of spatial data following tabular

data attached to them. Designed on the Windows Desktop as Windows NT, Windows

2000, Windows XP, Windows Vista and Windows 7. The software has 3 standard

application of ArcMap, ArcCatalog, ArcGlobe and ArcToolbox. ArcGis provide

applications that can adjusted with the capabilities and needs of its users.

 ArcMap : designed to display data, editing, spatial analysis and printing high

quality maps.

 ArcCatalog : functions to access and arrange data management (spatial and non

spatial data) with easily. Use of the bus looking for the desired data, display, view

or create metadata. ArcCatalog can also access external databases (Ms Access,

SQL Server, Oracle, etc.).

 ArcGlobe : designed to display data in 3 dimensions.

 ArcToolbox : contains the tools (the tools) for various geoprocessing and data

conversion between formats.

II. Objective

 Introduce common functions found in Arc GIS

 Providing training to use and analyze spatial data and attribute data and how

to manipulate the data
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III. Getting Started Using ArcMap Application

1. Starting and Opening Project

a) Open the Arc Map, Click Start, select Program, select Arc GIS and select

Arc Map or double-click icon

b) Then appear Arc Map Startup dialog box. When will open a new work sheet

select a new empty map and when we will open a map that was created

earlier select Open an existing map.

c) It would appear one data frame

Open file lu_1 pada D:\@-IK-Training\Modul-01-PengenalanGIS\RBI

Tangerang
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2. Tables of Contents

Every map has table of content. Some map showing all the layers on a single data

frame. Table of content will show how the layers are arranged in a single frame of data.

When displaying a map, usually we'll use the table of content to activate or deactivate a

layer. At the moment we want to form a map then that would a lot of work is a table of

contents included in the add, remove and determine how the layer is displayed.

How/ steps showing Table of Content :

a) Click menu View, on standard toolbar

b) Click on table of content

c) It would appear Table of Content
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3. Displaying Data View and Lay Out View

Arc Map has two View : Data View and Lay Out View

Data View allows you to display data and explore data, how to bring it up

is by clicking the image at the bottom of the frame data.

Lay Out View useful to prepare maps when will the lay out, to be inserted

in the report and to publish on the web.

4. Enabling or Disabling Layer

By default, all layers in the project will be displayed in the window view. This is

indicated by a check ( ) in each theme. This means we can view spatial data in the

Table of Content.

To set a particular theme that is not shown, we can make these themes seem or not (on

or off) by clicking on the check so that the check was not displayed. Conversely also, if

we want to show again the theme.

5. Tools On The Toolbar

ArcMap provides several tools that can be used for bias interacts with data, the tools

are :

Zooming

ArcGIS provides Zooming function (enlarge and shrink) to change the map scale to view

the document. We can do it with three ways to use the menu, button or toolbar.

Zooming using button

Zoom to Full Extent. This button is used to view the overall theme (all

spatial data is displayed).

Zoom In. Button is used for magnification once the center of view as a

central point.

Zoom out. This button is used to small once the center of view as a

central point.

Zoom to Previous Extent. This button is used to display the state of

zooming back we used previously.

Zoom to Next Extent.
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Tool Zoom In. This tool is used for magnification once by placing the

cursor position as a central point. If the button is clicked and the cursor is

placed on the map and then clicked and held (click and drag), making a

rectangle, it will display the field that we choose these areas.

Tool Zoom Out. This tool is used to small once by placing the cursor

position as a central point. If the button is clicked and the cursor is placed

on the map and then clicked and held (click and drag), making a

rectangle, it will display the field that we choose these areas.

Pan

This tool is used for sliding on the map, by clicking the left and move

towards the desired pointer.

i. Select Features Tool

This tool is used to choose features that we want.

Click on these features, or slide the mouse pointer around the features.

Select Elements Tool

This tool is used to select graphical objects such as lines, dots, labels or

the north and the other, by using this tool to resize draw bias and remove

the object.

Identification Tool

This tool is useful for displaying information about selected features, as

follows:

a) Click Identify tools



8

b) Click the mouse and point the pointer to the data that will identify

c) All existing data on the visible layer will be identified.

Find

This tool is useful for finding information on a feature allows you to search based on

specific information.

Searching for data with certain attributes

a) Click the Find button on the toolbar tools

b) Click the Features tab

c) Type the word you want to display the Find Text box

d) Click the down arrow in the In and then click on the desired layer or can be selected

Visible Layers

e) Put a check box in the Find Features that are similar to or contain the search string

f) Select an Option on the columns that will be in the search, example all fields.

g) Then click Find
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Measure Tool

This tool is useful for measuring distances on maps, will appear as a long distance

from the line segment in the status bar, with the following stages:

a) Click the Measure button on the tool toolbars

b) Move your mouse pointer to draw a line that describes the distance that want to

be measured

c) The line can consist of several segment

d) At the bottom of the frame will display the data segment that measured distance

and total distance of all segments

Segment :0.47865 Total: 2.2409 Km

e) Click 2 times to end it

6. Starting and Call Data

Calling Data Shape file Format

Open the Arc Map, Click Start, select Program, highlight Arc GIS and select the

Arc Map or double-click the icon

a) Then appear Arc Map Startup dialog box and select a new empty map.

b) It would appear one data frame

c) To call and add data to the data frame click the Add Data button, add the data to

be displayed

d) Then select the file feature class that will be displayed

Segment :0.47865 Total: 2.2409
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e) Click Add button to continue the call data process. After all process is finished

can be seen in the data frame.

Add



11

7. Deleting One Layer in ToC

If the data that has been called and has appeared on the ToC, we used not to

remove the data that is in the following steps:

a) As an example we will remove the street layer

b) Enable layer street layer

c) Then right-click to display the pop up menu

d) Choose Remove menu path to remove the street layer

Perform the same stepss to remove the other layers

in the data Frame

8. Setting Layer Name

Layers contained in the data frame bias in the settings and changed its name in

accordance with the information it has, for example layer Lu_1, will be replaced with

land cover. Steps:

a) Select layer Lu_1. Then right click and select properties

b) Select general tab in the layer properties dialog box then change the name of

the layer on the layer name dialog box with the village administration.

c) Click Apply to change the name of the layer or press F2 on the toolbar name

those layers.

9. Layer Setting

If the data displayed on the frame data is overwhelming, so the data should be sorted

according to the TIPA data, ranging from points, lines and then broadcast. For data

which is located at the top then the data will be placed on the top, this will be very

influential if the data area placed at the top, this data will cover the data with a line or

point data type. Layers can be arranged by clicking on the layer and moving it

upwards or downwards according to the position of the chill.
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10. Create Categories On Feature

Category features the same group data based on the value of its attributes, examples

of land use will be classified into residential, field, fields, marshes and others in

accordance with information on data attributes.

Map of Unique Value Based

Map is usually described by attribute data that can identify each feature.

Example: display layer based on the district lu_1, and steps :

a) Right click the layer lu_1

b) Select Properties and Layer Properties dialog box appears and then select the

symbology

c) Click on the categories and sets option of unique values

d) Set unique values based on the district name in the Value Field combo box

e) Set the color scheme and then click the Add All Values

f) Then click the Apply button to activate the settings made
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IV. ATTRIBUTES DATA

Geographic information system has two data elements are spatial data and attribute

data. Spatial data refers to the geometric data that provides information on the object

position and also the spatial relationships between objects, while the attribute data is

data complement of spatial data that provides additional information about the bias of

spatial data in the form of the id, name objects, etc. In the neighborhood Geographic

Information System data is stored in table form.

1. Exercise At Attribute Data

In this exercise we will try to do the editing and changes to the attribute data so it can

be done the analysis on the data attributes.

Open a new file map and then enter all the data contained in the folder "D: \ @-IK-

Training \ Modules-05-PengenalanGIS \ RBI FC" into the data frame and steps:

a) Click Start button-Program-highlight ArcGIS and then click ArcMap.

b) Click Add Data button to enter data into the map frame.

c) Select the data contained in the folder "D: \ @-IK-Training \ Modules-01-

PengenalanGIS \ RBI FC", select all the spatial data contained in the folder and

then click the Add button.

d) Arrange the data and show the layers of administration based on the unique

value of attribute data sub-district.

A. Opens the Attribute Table

Exercises in each data attribute contained in the ToC and steps:

1. Right click on the layer lu_1 contained in the ToC

2. Then select the Open Attribute Table

3. Then came the attribute table lu_1
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B. Adjusting columns in Table Attributes

Exercises change column width attribute on table administration and steps:

1. Put the mouse on the end of the column to be widened.

2. Click and drag the mouse in accordance with the width of the chill.

Exercise set position on the attribute column lu_1. and steps:

1. Place the mouse at the end of the column you want to move its position.

2. Click and drag the mouse toward the desired.

Exercise freeze columns in the table attribute lu_1. and steps:

1. Place the mouse pointer on the column that will defreeze.

2. Right-click and then select Freeze / Unfreeze Column.

3. Then slide the horizontal scroll bar to see results

Exercise sorted value lu_1 attribute table based on a particular column using

descending and ascending and steps:

1. Place the mouse pointer on the column whose value will be sorted.

2. Right click and select Short Descending menu. Similarly to the menu

Ascending Short, and steps :

a)Place the mouse pointer on the column whose value will be sorted.

b)Right click and select Short Descending menu. Similarly to the menu

Ascending Short.
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C. Set Display Table

Exercises change the font on the table with the Tahoma font with a green color

and size 9, and steps :

a) Click the Options button and then select the Appearance menu.

b) Setting font type to Tahoma, size 9 green color in the Attributes window u_1.

Exercises change the color of the selected data with the color yellow, and steps:

a) Click the Options button and then select the Appearance menu to display

the Table Appearance window.

b) Set the Selection Color in yellow.

D. Choosing Data Table

In the table we can choose the attribute data in accordance with the criteria that

we want by choosing to direct the mouse pointer to the data and we can do this

manually.

Choosing the first ten data on administrative layer attribute table, and steps :

a) Open the attribute table lu_1 layer.

b) Press Ctrl and then click the first data on the far left column, hold and drag

the mouse until the data to ten.
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Changing the selected data with data that has not been selected, and steps :

a) Right click the layer of administration.

b) Choose the Selection menu and then click Switch Selection menu.

Before selection switched After selection switched

Selects all data in the table attribute lu_1, and steps :

a) Right click the layer of administration.

b) Choose the Selection menu and then click Select All.

To disappear Select All on the data, can perform the following steps :

a) Right click the layer of administration.

b) Select the menu and then click menu the Clear Select Features.

2. Choosing Attribute Data

We can do the analysis using the data attribute.

A. Looking for a certain data

We can determine the specific data of the many data we have to use certain values

such as ID, name the object or other information.

 Looking for object description = sawah, and steps:

a) Open the attribute table lu_1 layer, then click the Option button.

b) Select the Find and Replace command
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c) Type "Sawah Irigasi" in the Find what text box and then click Find Next to

find the desired data.

d) Click Find next button to get the data "Rice Irrigation" the other. If no data

"Rice Irrigation" the other, then in ArcMap will display a warning message.

B. Choosing Attribute Data Using SQL Expressions

Arc Map has the ability to process the request using SQL expressions, when using a

SQL expression, we have to make an expression on the dialog box Select By

Attributes.

SELECT * FROM table_name WHERE Expression

Select all the data on land coverage layer attribute table whose ID is more than 500

use the SQL Expression Select, and steps :

a) Open the table attribute lu_1 layer.

b) Click the Selection menu and choose Select By Attributes.

c) Ensure that the selected layer is Lu_1 (check the Layer text box)

d) Write a SQL expression: "Keterangan" = "Empang", then click the Apply

button to select all the data that has Keterangan = Empang
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SQL Expression Selection result

3. Attribute data manipulation in Arc GIS

After we have explored a lot of spatial data in Arc Map and customize the data

attributes, we can also add and editing tabular data. Before doing the editing on the

table, we must activate the Editor toolbar and select the layer you want to edit

attributes. For example, to edit the data lu_1.

 Editing Record in the column

a) Click Start edit session on Arc Map

b) Open the table you want to edit

c) Click the cell you want to edit

d) Type the new data and press enter

 Adding new record

a) Click the Start edit session on Arc Map

b) Open the table you want to edit

c) Click the move to get to the last row in the table

d) Click the cell you want to add data and type the new value

 Delete record

a) Click the Start edit session on Arc Map

b) Open the table you want to edit

c) Select the record you want deleted, press and hold down the Ctrl key to select

another record

d) Press the delete button on key board
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4. CALCULATING AREA, LONG AND POSITION

To calculate the area of an area can be done by making a simple formula using VBA

scripts (Visual Basic), as well as to calculate the length and position of a location.

The steps are performed:

a) Open ArcGIS and then come up with data that will be calculated the extent

b) Click the right mouse

c) Select Open attribute table

d) Add a new column to put the broad in the attribute table

e) Click Ok

f) Highlight the new column

g) Click the right mouse

h) Select the "Calculate"

i) The Emerging Field Calculator, there is a choice of yes and no

j) Select yes

k) and enable advanced
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To calculate the area write the formula in the fields

A. Calculating area

Example of a simple formula that uses VB for extensive calculations, where the unit

area is calculated based on coordinate system:

Dim Output as double

Dim pArea as Iarea

Set pArea = [shape]

Output = pArea.area

Output

B. Calculating length

Unit length is also calculated according to the coordinate system used on the maps,

using VB is an example formula:

Dim Output as double

Dim pCurve as ICurve

Set pCurve = [shape]

Output = pCurve.Length

Output

C. Calculating the position of x and y

Value of location position, eg in the form of point / points can also be determined

based on the latitude and longitude coordinates, the formula is an example:

Dim Output As Double

Dim pPoint As IPoint

Set pPoint = [Shape]

Output = pPoint.X

Output

For y or longitude value in the formula above where the letter x is replaced with the

letter y. In the field "Field Calculator" column of the most under populated "output". If the

desired formula is written correctly then the next steps is:

 Click OK
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Wait until the process is complete, the calculated area will appear in m2 (depending on

the map coordinate system used)

5. Displaying Data Attributes In Graphic Form

Charts can display information from the data on maps and explain the relationship

between the data in an attractive and easy to understand. The graph can also display

other information relating to the data on a map or can also display the same data in

different ways. Graphics complement the map because it can provide complete

information and easily understood and can quickly compare the data with each other.

Create New Graph

ArcMap makes it easy to create a new chart based on attribute data, and easily paste

them on the map, and steps:

a) Open the attribute table of the layer lu_1_utm

b) Click the Options button and select Create Graph

c) Select the type of chart to be displayed and the sub type
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d) Set the layer value field with the value of extensive field, enter the x labels etc.

e) Click the Next button to continue the process.

f) Set the display of graphics such as the name of the graph, the Y axis, X axis (axis

properties) and others

g) Click the Finish button, to end the process.
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V. PROJECTION SYSTEM

Projection is a way of displaying the object with a specific shape and dimension and

into another dimension. Map projection means a way to convert the three-dimensional

position of a point on the earth's surface into two-dimensional representation of position

on the media map. Projection system means all things (including mathematical models),

which involves depictions of the earth's surface in two dimensions.

A good map projection system must meet criteria such as:

- The earth's surface depicted on the map has not changed.

- The surface area of the earth's surface area similar to that depicted on the map (after

taking into account the scale factor).

- The distance between the earth's surface point equal to the distance between points

on the map (after taking into account the scale factor).

- The direction and angle between points of each other and should remain unchanged

(after taking into account the scale factor).

Purpose

- Introduce the concept and stages of projection maps / data vector

- Can perform projection transformations on vector data

a) Definition of projection on the layer

In processing the data in ArcGIS we have to get used to define the coordinate

system on the layer to smooth the processing.

Go to view>the data frame properties : select the menu tab “data frame”
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Then we predefined coordinate the desired system: for example Predefined>

Geographic coordinate system> World> WGS84

b) Defines vector data that do not yet have the projection system

Open the file "garis_pantai_1" in D: \ @-IK-Training \ Modules-05-PengenalanGIS \

RBI Tangerang. If the file has not been define vector coordinate system, we can see

the layer properties on the tab "source": Coordinate system <undefined)

To define this feature we select the menu on the toolbox Data management

tools> Projection and transformation> Raster> Define projection
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Choose a coordinate system coastline on geographic coordinate systems> World>

WGS84> OK

c) Transformation of projection on a vector data

At this time steps will be served vector data that have a geographical projection

system, we will transform into a universal form Tranvers Mercator.

Select meno on tool box ……Data management tools >Projection and

transformation>Feature>Project

Enter data input “lu_1”

Enter the new file name in the “output dataset”

In the Output folder coordinate system, enter the coordinates system

The new "projected coordinate system> UTM> WGS84> Zone 48S
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VI. GEOREFERENCE

Georeference is to give value analog coordinates on a map or maps that have not

been corrected geometric. This process is the stage before we want to make the process

of further geographical analysis such as digitized maps.

Objective

Introducing the concept and stages georefence

Working Steps

Raster data is one of the commonly used data on the environmental information

system is usually presented data thematic geographic data raster, such as land use,

geology and other. To use raster data should be, the data in advance so that corrections

can be overlay with other vector data.

1. Georeference Process Based On Information Grid Map

Georeference process requires a minimum of 4 points of known coordinates so that

data can be in a correction to the coordinate system, and steps:

a) Create a new frame folder, then click the Add Data.

b) Call the data contained in the folder "D: \ @-IK-Training \ Modules-02-

PengenalanGIS \ RBI FC \ Teluk Banten"

c) Come up with Georeferencing tools
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d) Click the Add button to continue the process Georeferencing

e) Then will appear Map

f) Click the add button control point

g) Click on a point that has the information grid coordinates

h) Click the view link table, and then edit the value X map and Y map based on the

information grid numbers

i) Repeat steps 7-8 to add the reference points, a minimum of 4 points.

j) Click the Georeferencing tool and then select Rectify. Set cell size and resample

type and output file names. Then click the save button (Ok).
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2. Georeference based on existing Spatial Data Geo-referenced

Raster data that does not have a system of coordinates can be transformed into

data that already has a coordinate system. Arc Map allows us to define the

coordinate system on data that do not have a coordinate system by registering the

data.

In this exercise we will try to register the data that do not have a system of

coordinates to data that already have data coordinates, and steps :

a) Open a new frame of data, then call Basemap.shp vector data and raster data

also appear map1.tiff.

b) Come up with georeferencing tools

c) Ensure the active layer is a layer map1

d) Click the georeferencing and select fit to display

e) Click the add control point button, then click the link, to add a link, point the

mouse pointer on the location of known and recognizable in the target data.

f) Click the georeferencing tool, then select rectify

Extract Feature (Digitize)

In this exercise we will perform extracts features a fault line by using the heads-up

digitizing (digitized directly on the monitor screen).

In ArcToolBox> Data Management Tools> Feature Class> Create Feature Class

created a feature class with the type of line (as below):
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Noted that for the spatial reference GCS_WGS_84 selected by selecting> select>

Geographic Coordinate Systems> World> WGS 84.prj and click Ok and Ok

means we are ready to create a shape file editing and ready to do the digitization:

Select Tools Editor> Start Editing and select Create New Feature with the

target file is created, (see below)

Note: The addition of control points should be done diagonally like the upper left, lower

right, upper right and lower left. To perform data modifications we live change the task

menu on the toolbar editing.

Folder

penyimpanan

Tipe

Vektor
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VII. CAPTURING DATA (DIGITIZATION)

Digitization is the process or analog over print media into digital or electronic media

through the scanning process, photograph digitation or other techniques. This usually

requires time, effort, and cost is not small. In the process of digitization, digitization

required expertise / technical high enough.

The objective of this process is:

 Introducing the concept and stages of digitization feature

 Practicing to capture data using a scanning tool found on Arc GIS

Before starting the digitization should first we create a place to store features the results

of digitization. Create the file in the Arc Catalog

1. Displays the Editor toolbar

a. Start Arc Map

b. Click Editor Toolbar on the standard toolbar

2. Starting digitization

Open the file "mauk_rec.img" D: \ @-IK-Training \ Modules-01-PengenalanGIS \

RBI Tangerang

Making a Point and a line by digitize

a) Go who want digitized raster data

b) Create a new feature such as "high point": ArcToolBox> Data Management

Tools> Feature Class> Create Feature Class
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c) Then open the Editor Toolbar, then select Create New Task in the Current

Task

d) Click the Start Editing want digitized layer

e) Click the Tools palette and select the Sketch Tool

f) Assign a single point on the map you want digitized

3. Making a Point by The Distance-Distance Tool

a) Click the Tools palette, and select the Distance-Distance Tool

b) Click once to determine the center point on the first circle and press D on key

board

c) Type the desired radius distance for the second circle and press enter

d) Position the pointer on the place you want to add point

e) A new point will appear on the map

4. Creating lines and Polygons by digitization

a) Open the raster data that want digitized

b) Create a new feature such as "garis pantai": ArcToolBox> Data

Management Tools> Feature Class> Create Feature Class

c) Click the Start Editing want digitized layer
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d) Then open the Editor Toolbar, then select Create New Task in the Current

Task

e) Click the Target layer and click the Line or Polygon

f) Click the Tools palette and select the Sketch Tool

g) Click on the map to digitize the desired features

h) To end it, double click

i) Line or polygon will appear on the map

5. Modified feature and Snapping

If the map digitize sometimes we want to continue my existing data. How the data

will be connected (no break). Just as when digitizing "garis pantai", we will continue

the process of digitization:

a) Open the feature “ garis pantai “

b) Click Start Editing want digitized layer

c) Select the feature you want to edit, then open the Editor Toolbar, then

select Modify feature on Current task

d) Continue the process of digitization
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Unify data line that has not fused the vertex

a) Click on the toolbar editor> Snapping. will display the toolbar Snapping

b) Check list for the features you want to edit, and check the edit sketch

c) Select the feature you want to edit, then open the Editor Toolbar, then

select Modify feature on Current task

d) Move your pointer over a feature that will display, then the pointer will point to

the last vertex.
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VIII. DATA PREPARATION CELL (GRID)

Visualization techniques applied to simulation models of coastal vulnerability along

the coast of Tangerang by dividing each location with a cell size of 1 km alongshore and

250 m to the mainland. These cells will be used to visualize the results of modeling of

coastal vulnerability index (IKP).

Purpose

Manufacture and preparation of cell data, spatial database design

Data processing

In the manufacture of cell data, which is required as reference data as a baseline

shoreline.

1. Open the file "gp_sel" in D: \ @-IK-Training \ Modules-02-PengenalanGIS \

Latihan

2. Perform the menu on the shoreline buffer: ArcToolbox> Analysis Tools>

Proximity> Buffer

Enter gp_sel data on the input feature, change the value of distance units, and side

type "RIGHT"
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3. Make cuts in the buffer as far as 1 km respectively.

Start editing the file "buffer_gp"> select feature> on the task "Cut polygon by

feature"

4. Next we set up a database on the cell, by adding fields for encoding data for later

data standard.

1km

Cut

polygon
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5. Preparation of cell data is done at 250 m in the direction of the mainland coastline

and 250 m buffer to the sea as much as 6 cells.
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IX. MAP LAYOUT

1. Settings page and print setup layout

1). ArcMap and load some data that need. Open the file in D: \ @-IK-Training \

Modules-02-PengenalanGIS \ Data layout

2). After all desired data has been there to call, then the Standard click View menu

and select Layout View, or you can also enter through the Switch button located

bottom left of the display map. In the standard layout is the default condition of a

vertical format with a size of paper/paper print letter/A4 and also in a state of

default options

3). To change the setting / display page layout you can go to the Page and Print Setup

on the File menu standard.
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a). In the Print Setup select the type of print used (if the layout is made larger than

standard size / default paper)

b). Then the paper select the paper size to be used, (if you do not have a printer

that larger size (A3, A1 or A0) you can perform a custom option and enter the

paper size you'll use In accordance with the scale of the map that you want

later

c). On the orientation of the map select whether vertical (Portrait) or horizontal

(Landscape)

d). Press OK when you have finished setting.

In layout view the map frame will be visible position is at the bottom left side of the

map because the paper size has been enlarged. Frame size of this map we

change the way pulled one point vertex (colored blue) towards the top right of the

layout.

4). Click and drag one corner of the map frame in accordance with the desired major.

After you enlarge the Data Frame will be otomatic scale of the map will change (note

the standard toolbar ArcMap). The size of the enlarged size is still a while since we

have not adapted to the scale and cropping as desired.

Setting the data frame / main layer

Setting a fixed scale and extend clipping (How to clip first)

In the map below there are two features of the map data administration and data

features Frame. Now we are set to display a map in accordance with the scale and

extents / frame as desired. The steps undertaken were:

5). Click / make sure the Data Frame elected / selected

6). In the data frame active / select press the right mouse button and select Properties.

To get into these properties you can also go to the View menu and select Data

Frame Properties.
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Data Frame Properties on the menu to do the

settings

e). Click Data Frame Tab

f). Select Fixed Scale, and fill the desired scale ratio

g). Press the Apply button to see changes in the map view

h). In the Enable Clip to Shape, and then click Specify Shape (this function is used

when we want to hide / hidden map view beyond the specified frame.

i). On Menu Data Frame Clipping Select / activate the Outline of Feature (if using a

polygon feature data as a source target clip.) extents Custom option, used when we

perform clipping by including a reference coordinate points.

j). Click OK button,

k). On the Border select the type and size of the boundary line

l). Then press OK

In layout view the map, is in conformity with the settings that you are doing both map

scale and clipping her. If size is not the same Data Frame Clip layout of the maps that

there could liken it to reduce/enlarge the size of Data Frame.



40

2. Data visualization layer

In the data that we have our bias visualization based on existing data (not a color) so

that the view is more interesting and representative.

Open layer properties in the data "tgr_cvi" and went into the symbology tab

 For single feature (one picture) select menu features> single symbol

 To display the unique data select categories> unique value: enter the desired value

based on value

 To display a value based on the sequence data (graduation) select quantities>

graduated color. Enter the desired value and set the class to be created "classify". We

can set the interval classes that will be created based on existing methods.
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3. Labelling

To display information on maps using data labeling, then the computer will automatically

display the information data.

Open layer properties in the data "toponomy" enter tabs "label"

 Check the labels list feature in this layer

 Change the Label field with text description

 To format the letter bias changed in the text symbol

 OK
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4. Creating a Grid System

a. Geographic Grid System

1). Make sure the Data Frame elected / selected, then on the Standard Toolbar

click the View menu and select Data Frame Properties, or click the right

mouse button select Properties.

2). Click Tab Grids

3). Click the New Grid button

4). In Which Do You Want to create, select Graticule: divide map by meredians

and parallels

5). Set the interval to be made

6). In the Grid Name you please replace the name of the grid or you select a

name in the default condition.

7). Click Next button

8). On the Appearance select the type of display grid (select Tick Marks and

Labels)

9). In the interval distance between the Input Value Coordinates (Latitude,

Longitude)

10). Click Next button
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11). On the Menu Axes and Label Allow the default condition, then press the Next

button

12). On Grid Properties select the Store That grid is fixed as an update with

change to the data frame

13). Click Finish button

b. Universal Transverse Mercator Grid System (UTM)

a). Make sure the Data Frame elected / selected, then on the Standard Toolbar

click the View menu and select Data Frame Properties, or click the right

mouse button select Properties

b). Click Tab Grids

c). Click the New button Grid

d). In Which Do You Want to create, select Measured Grid: divide map into a grid

of map units

e). In the Grid Name you please replace the name of the grid or you select a

name in the default condition.

f). Click Next button

g). On the Appearance select the type of display grid (Style)

h). In the interval distance between the Input Value Coordinates (Meters)

i). Click Next button

j). On the Menu Axes and Label Allow the default condition, then press the Next

button
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k). On Grid Properties select the Store That grid is fixed as an update with

change to the data frame

Click Finish button

You have to manufacture two of the UTM grid system and Geography. But on the

grid by default labels on UTM raises particular decimal, while for the left and right

labels on the grid geography appear horizontally. For that we need to set the grid

style to look more tidy and the second grid system labels do not coincide with each

other.

5. Frame Design with Drawing Tools

Now we do manufacture frames and perform design in the layout by using the function

on the tool drawing. The function of these tools may not be familiar to you if you are

already accustomed to using it in application programs made by Microsoft (Word, Excel,

and Powerpoint, etc.).

Now we make some boundary lines (Frame) in the layout

a) On Drawing select the Rectangle tool (a rectangle) and then describe the layout by

confining all the elements in the layout

b) Move the rectangle is backward object as a whole element layout background.

c) Use the Drawing line to make some boundary line to separate the theme of objects

in the layout. And use other functions such as the Fill Color and Line Color and other

functions.
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6. Description and Map Information

Adding the Insert / Chart Map

1). Click on the Insert Toolbars Standard and Select Data Frame

2). In the conditions selected / elected to add the reference data as a diagram the

position of the main map, and then complete the grid, geography. Frame Data Name

can be changed with a new name.

Adding Eyes Wind Direction Signs

1). Click on the Insert Toolbars Standard and Select North Arrow; Select Type / Type of

the wind direction

2). Click OK button

Add and Edit Scale Bar Map

1). Click on the Insert Toolbars Standard and Select Scale Bar

2). Select Type / Type Scale used (select Alternating Scale Bar 1)
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3). In the When resizing select Adjust width

4). In Division Value length scale input values created

5). Fill Value Number of division and subdivision so the value of 2 (two)

6). In Division Unit Select a folder created scale units

7). Edit the label scale

8). Click the OK button

Adding Map Legend

1). Main Data frame Click (Selected)

2). On the Insert menu Then Select Standard click Legend

3). Select the layer-layer features to be shown a legend (Put on Legend items)

4). Click Next button

5). Legend Title Edit (Text, Color, Font Size and Type font) If you need, then click the

Next button.

6). Click Next button
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7). For the meantime we just select the default first, but if you need to edit his pacth

please try it, Click Preview button if you want to see change if you do editing pacth

8). Click Next button

9). Click Finish

Adding a Text Description Map

1). On the Insert menu and select Standard Click Text or you can use the Text in the

Drawing tools

2). Click On display layout and content with the text. For editing you can click the right

mouse button and select Properties

3). Click the OK button

4). You can also format the size, color, and font type using Drawing tools (Make sure the

font is still in the elected / selected) and click OK
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Adding Logos and Images

1). Click the Insert In Standard Menu, then select Picture

2). In the Look In: looking for a logo or an image folder location that you input

3). Select the file name (logo / image)

4). Click the Open button

5). Edit picture (size) to move place format.
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7. Saving map

Storing into the Project and Templates

1). On the Standard menu Click File and select Save As

2). In the Save In: Choose a Folder as a storage location or a template Project

3). In the File Name Enter Name

4). In the Save as type Choose whether you save it as *.mxd Project select, but if you

want to keep it as a template select *. mxt

5). Click Save button

Project Export Layout to format Raster / Images

1). On the standard menu click File and select Export Map

2). In the Save In: Choose Folder Venue Map data is stored Raster

3). In the File Name; Enter Map Name

4). In the Save as Type, select the extension of data storage formats that you want.

5). Click Save button
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I. Introduction

In determining index of vulnerability coastal, the component of geomorphologic is

one of variables that need to be assessed. Geomorphology is the study of landscape

(landscape), including the nature and characteristics from morphology, classification,

difference and responsible process toward the formation of morphology.

Geomorphological process is a natural process that took place on the earth

surface so that there is a change of land forms on the surface of the earth. Changes in

land forms, resulting in formation on the surface of the earth that differ from one another,

thus will have a range of composition and physical characteristics and different visual.

These differences can be clearly identified through the characteristic relief / morphology,

structure/lithology, and processes, geomorphology. Basically, in explaining the

characteristics of land form a region, therefore the classification of landform units (third-

order relief) that is characterized by forms on the earth surface on the basis of the

characteristics possessed by each group form the earth's surface. Landform

characteristics mainly influenced by the surface configuration (relief), the characteristics

of geological structures or rock types, and characteristics of the processes that result in

the form of land.

Based on morphology, the coastal areas can be grouped into 4 types, namely:

a. Steep rugged coast (cliff)

The beach is a steep rugged landform formed by the marine erosion of the most

widely available. Roman cliff formations and different from one another, because it is

influenced by rock structures and rock types and rock properties. Cliff on igneous rocks

would have been different with a cliff in sedimentary rock. Sedimentary rocks such

coatings will be different with a sloping plating and coating flat. In the border area above

the waves, are generally covered by vegetation while the lower part generally in the form

of rock outcrops. Tidal and wave activity eroded the cliff, thus forming the abrasion marks

such as: cliff, cliffs dependent (notch) and the average tidal wave.

On steep rugged area, beaches are usually rocky (rocky beach), a winding with

many of the rock mass movement (mass movement rock fall type). This process moves

backward cause cliff (slope retreat), particularly in coastal abrasion process is active. If

the rocks making up this region of limestone or other rock that has many cracks (joints)

of inland water flowing through the system cracks and pops in the coastal areas and

coastal regions. In Indonesia, steep rugged coast are numerous in the western part of

Sumatra Island, South coast of Java, Sulawesi, and South coast of the islands of Nusa

Tenggara. Cliff dependent (nocth) is also a cliff, only on the cliff near the sea surface

curved toward the ground, so that there are niches in the cliff. Recesses occur as a

result of the collision wave continuously into the cliff wall. When the roof is not strong
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niche, the cliff is a cliff will collapse and become flat back and in front of the beach there

are a lot of material in the form of blocks or chunks of various sizes.

The average tidal waves on the steep rugged coast is a zone that is sometimes

submerged in sea water at high tide and sometimes dry during low tide. The average

tidal wave is often also a beach with material that can be fines up to rough waves that

depend on the strength of that work on coastal cliffs. Under these tidal flats exist in the

form of a harder material contained beach sometimes called the Plat form.

b. Coastal coral reefs

Coral reef is formed by the activity of coral animals and other microorganisms.

This process occurs in areas large enough. Bird (1970: 190-193) states that the coral

animals can live with certain conditions ie conditions: clear water, the temperature not

more than 18oC, salinity between 27-38 ppm, ocean currents are not heavy. Coral reefs

are a lot surfaced numerous in the Indonesian archipelago. On coral islands which rise

generally there are many deposits of debris and coral sand off the beach. Rubble and

sand grain size is more coarse in the direction of wave if the wave without hindrance.

Tectonic processes often influence also on coral reefs. Atoll is the result of a combination

of the coral animal with tectonic processes in the form of subsidence.

c. Bergisik beach

Bergisik Beach is basically a tidal area that contained the results of abrasion

material deposits. This material can be a fine material and also can be a rough material.

The beach is marked by a beach on the coast cliff with coarse material as a result of the

abrasion cliff. But do not just coast bergisik found on the beach cliff, but can also be

found on a sloping beach area. On a sloping beach material is mostly sand beach, and in

part the form of small grains of material with gravel up to a bigger one. In general, beach

sand, a beach from inland areas under river water into the sea, and deposited by ocean

currents along the beach. This beach can be found around the mouth of river.

d. Coastal brackish swampy

Brackish marsh also characterizes the coastal region that grows or accretion. The

process of sedimentation is a cause of increasing the advance towards the sea coast.

Composition, this beach is generally fine grained and the field is growing on a small

wave locations or obstructed and the condition of sea water is relatively shallow.

Because the water is brackish, then this area is very limited possibilities for development.

Brackish marsh are generally covered by brackish marsh plants such as mangroves,

palm, and other marsh plants that live in brackish water. These mangroves may function
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as a breakwater and a barrier on beach erosion, sedimentation opposite could happen.

Hence accretion beach experience. Role in stimulating the growth of mangroves in

coastal mangrove proved obvious if the missing or dead, cut out, then what happens is

the opposite of beach erosion. On the beach experience accretion, generally there is a

sequence that there is mangrove at the front, behind palm, plants, fresh water marsh/

wetlands. Upper limit of mangrove is as high as the maximum high-water mark. The

surface of the highest tides occur at the time of spring tide (when the full moon) and pairs

neap tide (at the time of the dark moon/month died).

The data used to identify geomorphological classes can be obtained from the

Map Arts Earth (RBI), RBI data which produce BAKOSURTANAL. Land data parameters

is fresh water, swamp forest, shrubs / bushes, Marsh, Point, Pond, dry land and irrigated.

Parameter data are then classed according to the class of indicators proposed by

Gornitz (1991). Groups of land cover types are:

1. Aluvial, include: Pond, Salting, Rice Irrigation, Rain fed Low, moor / Field.

2. Briny Swamp, including: shrubs / bushes and swamps.

3. Mongrove forest, including: Swamp Forest.

4. Beach building, including: building of Settlement.

5. Estuary and lagoon covers: fresh water and coast land.

6. Beach Sand, includes: sand beach and sand land.

The last parameter of the morphological class of low rugged coast, beaches are

rugged and high rugged coast is calculated by using the slope of the terrain near the

coast of elevation data or Quick Bird satellite imagery of Google Earth.

The preparation of geomorphological data obtained are grouped into classes in

the modification of Thieler and Hammar-Klose. 2000; USGS as follows:

Class
Parameter Very

Low
Low Medium High Very High

Geomorpholo
gy

High
cliff

Medium
cliff

Low cliff,
aluvial

Building,
Estuaries,
Laguna

Beach Building
Structure, sandy
beaches, brackish
swamps, mud
Expose, Delta,
Mangrove, Coral

Geomorphology data is qualitative data so that in determining the coastal

vulnerability index data needs to be converted into quantitative data. Value of weight on

each hump as follows:
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1. Very low class is a value of 1

2. Low class is the value 2

3. Medium class is a value of 3

4. High Grade is a grade 4

5. Very high class is the value of 5

II. Objective

The objective of this module is that each participant is able to do the acquisition,

processing and integrating data for the determination of geomorphology Coastal

Vulnerability Index (IKP).
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III. Stages of Data Acquisition Geomorphology

1. Open file “data_geomorfologi” and “Landuse” in folder D:\@-IK-Training\Modul-03-

Geomorfologi\Data

2. Do clip geomorphology data (file : landuse) with cell data (file : geomorphology data)

do with click ArcToolbox select Analysis Tools select Extract select Clip,

will appear like the picture below.

ArcToolbox
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Contents geomorphological data (files: landused) on Input Features and cell data

(files: geomorphological data) to the Clip Feature like in the picture above. Click Ok,

the image will appear as below, click close

3. To integrate the data table then do the Union on the data resulting clip with cell data

geomorphology. Click the ArcToolbox select Analysis Tools select Overlay select

union, such union table will appear below.

Enter your data files and data_geomorfologi Landused_Clip on "Input feature" click

Ok will appear like the picture below.
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Click close. So that the data are integrated in one file. Data tables are the result of

integration can be seen by the right-click "Landused_Clip_Union" select open

attribute table will display table that is generated as follows:

4. Change coordinat system on the layer into the UTM system is done by right-clicking

the layer select properties select predefined projected coordinate systems select

UTM select WGS 1984, because of the location used is the Tangerang Municipality

then select WGS 1984 Zone 48S.

5. Calculate the area of vector data "Landused_Clip_Union" in each cell is done by

opening the data table "Landused_Clip_Union" add a column in the table by clicking

options at the bottom of the table select the add field will appear as in the picture

below, give the column name such as "area" change the type to double, click Ok.
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So on the table "Landused_Clip_Union" had increased in the column "area" as in

Figure below.

Right-click on the "area" in the table select calculate geometry, click Yes the image

will appear as below:
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Click Ok will show the value in the "area" as shown below:

6. Export data table "Landused_Clip_Union" into the format. ".txt" so that it can be

opened in Excel with the click select export options will appear the image below :

Change to the directory to the choose directory, done by click on Browse will display

the image:

Give the desire file name such as “luas.txt.”
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IV. Interpretation of the Qualitative Data To Quantitative Data Geomorphology

1. Open the file "luas.txt" using excel program. Input wide value landused every cell in

the table below

No Sel Empang
Sawah

Irigasi

Penggar

aman

Tegalan/

Ladang

Kebun/

Perkebunan
Air Tawar Gedung Pemukiman

Pasir

Pantai

Belukar/

Semak

Pasir

Darat

Rumput/

Tanah

kosong
Mangrove

1 23970.1 89328 26976 35553.6

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

Then grouped into broad landused every cell in the appropriate classes as in the

table below and provide value by:

1. Very low class is a value of 1

2. Low class is the value 2

3. Class Medium is the value 3

4. High Grade is a grade 4

5. Very high class is the value of 5

By considering the large percentage of every landused contained in a single cell.

Sangat

Rendah
Rendah Sedang Tinggi Sangat Tinggi

Tebing

Tinggi

Tebing

Sedang

Tebing Rendah

dan Dataran

alluvial

Bangunan,

Estuaria,

Laguna

Struktur Bangunan Pantai, Pantai

berpasir, Rawa payau, Paparan

lumpur, Delta, Mangrove, Karang

1 0 0 140274.2279 0 35553.59561 175828 3.40

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

LuasSel
No

Sel

Kelas

Nilai
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2. After the value of variable geomorphology in each cell is obtained, enter that value

into cell "data_geomorfologi" on ArcGis.

3. To enter the value from excel program to ArcGIS program, we can use the Join menu

table in ArcGIS. At first the contents of a value into the table where every cell has the

coordinates x, y as shown below. Save As table into txt format, for example

nilai_geomorfologi.txt.

4. Call the processed data (file name: nilai_geomorfologi.txt) in a way: Click on Tools

select add xy data will appear like the picture below.
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Click browse on the Choose a table from the map, select the file

nilai_geomorfologi.txt, initialization x field with the value longitude, and y fields with

value latitude. Determine coordinat system in use by clicking the edit will appear like

the picture below:

Click the Select button will display the picture as below:
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Click the geographic coordinate system, select the word select WGS 1984 as shown

below.

Click Add, click Ok, then in the Layers will appear nilai_geomorfologi.txt file events.
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5. Right-click the file data_geomorfologi, select the join and Relate, select the join

It will appear like the picture below. Select KODE_SEL on the Choose the field that

the joint will of be based on. Click Ok.

Once completed, the geomorphological data in each cell is already available and can

be used to determine the value of CVI.
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6. To view the data geomorphology Data_Geomorfologi then right-click the file, select

open attribute table, geomorphological data table will appear as below:

7. Geomorphological data export by right-clicking the geomorphological data, choose

Export, name the file.
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I. Introduction

Sea-level rise is one of the parameters used in determining the vulnerability of

coastal areas. This phenomenon will cause flood some coastal areas even able to

submerge small island with a low slope in the time period is generally relatively long, so

higher the sea level rise in a region and the sloping topography, it can be said the region

are vulnerable. Determination of this process would require the observation of sea

surface height information for a relatively long, so sometimes difficult to obtain accurate

information for a variety of vast coastal areas such as Indonesia. Determination in situ

sea level rise is done by measuring the water level with the tide gauge, since the

development of satellite technology then this process can be observed by using satellite

altimetry. Observation of sea level with tide gauge and satellite altimetry can certainly

complement each other information about sea level rise, where these data can be

combined (merged) and the reanalysis process.

Data trend of sea level changes can be obtained by satellite altimeters such as

TOPEX/POSEIDON. Jason JASON 1 and 2 which can be downloaded at the site

http://www.aviso.oceanobs.com/en/news/ocean-indicators/mean-sea-level/index.html.

The resulting data format NetCDF (Network Common Data Form) using a grid system

size 0,25ox 0,25o or approximately 27,8 km x 27,8 km and is available from October 1992

to July 2009 with worldwide coverage. In Figure 1 can be seen that the global sea level

rise (GMSL) of approximately 3,32 mm/year, calculated after removing the annual signal

and semi-annual seasonal patterns include screening, atmospheric pressure, sea

baroclinic process and the influence of wind. Filter 2 is applied monthly to the blue dots,

while the 6-month filter used on the red curves and applying the correction to postglacial

rebound (-0.3 mm/year). Calculation of global sea level rise uncertainty analysis of each

correction altimetry and comparison with tide gauge trends that give an error of about 0,6

mm/year at 90% confidence interval.
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Figure 1. Trends in global sea level rise from AVISO (October 1992 - July 2009).

Figure 2. Regional MSL Trends from AVISO (October 1992 - July 2009).

II. Objective

The objective of this module is that each participant is able to do the acquisition,

processing and integrating data trend of relative sea level rise to the determination of

Coastal Vulnerability Index (CVI).
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III. Data Processing

Data processing changes in sea level trends (Sea Level Trend) can be done using

two methods. Method 1 is the process of manual that is quite effective for data that is not

too large. Method 2 is much more effective for large data because the process is

assisted with programming. The use of these methods is also determined by the ability of

participants in particular an understanding of the basics of BASIC programming

language. The second method starts by extracting data netcdf format (*.nc) by using the

ODV (Ocean Data View) into data formatted text (*. txt) in a wider area than the desired

limit. This was done so that the interpolation results for the better. For the purposes of

more detailed information as input in a cell at the beach it is necessary to interpolate to

the size of spatial grid can be adjusted to the desired cell size by using Surfer (eg 1 km x

1 km). The result is truncated interpolation (cropping) as the desired area and exported

into XYZ format data using Global Mapper. The last to enter the cell closest to the

shoreline then be overlaid with coastline cells and digitized by using Surfer.

Method 2 performed after interpolation with Surfer and then Program 1 is used to

determine croping area after interpolated, where the program lines can be seen in

Section VIII. Results from Program 1 as input to Program 2 which run with Macro MS.

Excel where the output of the nearest value in the cell the coastal. The overall result of

this process is made in a table that will serve as input in the process of data integration

in GIS. The data processing stages can be viewed in flow chart in Figure 3.

Sea Level Trend
Data (AVISO)

Ocean Data View :
1. Read Data Format
2. Cropping Data
3. Export Data

Surfer :
1. Interpolation
2. Eksport Data

Global Mapper :
1. Cropping Data
2. Eksport Data

Surfer :
1. Overlay with Coastal Cell
2. Digitation

Program 1 with
Surfer Scripter:
1. Read Data Format
2. Cropping Data
3. Export Data

Program 2 with
Macro Excel:
1. Read Data Format
2. Cropping Data
3. Export Data

Method 1
Method 2

ID Location
(Position of center
coastal cell)

Surfer :
1. Interpolation
2. Eksport Data

Output
to GIS

Output
to GIS
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Figure 3. Flow Chart of Sea Level Trends Data Processing to GIS Integration data.

IV. Extract Sea Level Trend Data in Netcdf format (*. nc) with Ocean Data View
(ODV)

1. Open file MSL_Map_MERGED_Global_IB_RWT_NoGIA_Adjust.nc with double-click

on the file, so that the display will appear as follows :

2. Select all variable in part Coordinates by pressing Ctrl and click one by one variable

or block with the mouse cursor so that all the variables selected and will appear as

follows :
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3. Click Next and will appear equating the variables that exist in ODV (Metavariabel) and

the data (source variable) which is marked with * following :

4. Click Next and select the Use Dummy Variable and click Next it will display showing

the distribution of data stations were as follows:
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5. Select Zoom into a Map and set appropriate limits red color desired area, this needs

to be done so in the process of reading the data becomes faster because the ODV

does not need to read the data overall (global). Having given the limits of the desired

area, double click on the domain and then click Finish and press F8 it will display :

6. Right click on the map and select Full Domain, it will display the distribution of

stations according to the area that we want the following:
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7. To obtain the text data from the distribution of stations according to the selected area,

then click Export and select ODV spreadsheet and save according to the desired

name.

8. To create a surface distribution, right-click outside the map and select Layout

Templates and Surface Windows or can simply press F12 and will appear as

follows:

9. Right click and select Accept so the display appears as follows:
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10. To make the better visualization for surface distribution it is necessary to perform

interpolation process with right click on distribution maps and select Properties and

select Display Style and then select DIVA Gidding on gridded field and set the X

scale Length (permile) and Y scale Length (permile) until distribution looks optimal.

Set the contour interval on the Contours and Contours Do check to make contours.
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V. Interpolation Data Grid with Surfer

1. Open the data that has been extracted in the format * txt in Excel. Selection of data on

the worksheet by selecting File and click New and then select Worksheet. The data

will be used is longitude, latitude and Sea Level Rise, where is the longitude column

A, column B is the latitude and column C is the Sea Level Rise. After the selected

data and then save it in txt format in folder * \ 2-Data_Eksport_ODV.

2. The data already in the format *txt then do interpolation with open the Surfer

worksheet click File select New Plot. After the worksheet and then use the command

appears Grid and select data. So it can be seen the picture as follows:

3. Choose x as column A, column B and y as z as column C, for we use Kriging

gridding method, output Grid file to the address file to save. Grid line Geometry we

just simply replace spacing with spatial grid size to 1 km x 1 km due in the form of

degrees we change to a decimal degree with the value of x 0.009090909091

0.009090909091 spacing, after all occupied click OK.
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VI. Cut Boundary Area and Export Data with Global Mapper

1. After Kriging process is complete and then converting the Grid into ASCII format

(xyz) by clicking the crop area will be used, by opening the grid in Global Mapper

program. Click Open Your Own Data Files and select the data grid that result from

surfer and we can be seen as an image as follows:

2. Click File and select Eksport Raster File and Elevation Data and then Export XYZ

Grid and click OK and we can be seen display as follows:

Change Lat/Lon, Global Projection, Corner w / size-Global Project to coordinate the

desired limit in accordance with the observation domain. Then press OK and Save

the file in a format * txt.
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VII. Find the Nearest Point of Sea Level Trends Data on Central Coastline Cell

1. To determine the value of Sea Level Rise position closest to the cell which is on the

beach every year for the cell data to be overlay with data points Sea Level Rise,

using Surfer software. First, open Sea Level Rise data poin on menu Map then

New and then Post Map and will appear as follows:

Second, to open a data cell by selecting File then Import and then Open file data

cell. It can be seen as following picture:



83

To be able to see the point of our stations can use the Digitize command with click

Map then Digitize and then click on the station point, having to point the

coordinates of Sea Level Rise with the closest distance, and then input the high

value of Sea Level Rise and depth coordinates of integration format. It can be seen

as following picture:
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VIII. Program to Extracts, Cropping, and Export Sea Level Trend Data After
Interpolated With Surfer

Run the Scipter in Surfer, then the initial display will appear as follows:

On the Edit menu choose Select All, then copy the program lines below and paste it in

sheet scipt. Furthermore, to perform program execution (run) click on the icon or
select Run Script menu or by pressing F5 on the keyboard. Be sure and adjust the
location of the necessary data directory data in the form of ODV export results are in
accordance with the location of the directory on line program. Next specify the storage
location of the executable program that has been interpolated grid data.

Sub Main()

' SETTING SURFER
On Error Resume Next 'Turn off error reporting.
Set SurferApp = GetObject(, "Surfer.Application")
If Err.Number <> 0 Then
Set SurferApp = CreateObject("Surfer.Application")
End If
On Error GoTo 0 'Turn on error reporting.
If SurferApp.Windows.Count = 0 Then SurferApp.Documents.Add (srfDocPlot)
SurferApp.Visible = True
SurferApp.WindowState = srfWindowStateNormal
SurferApp.Width = 1024
SurferApp.Height = 200
SurferApp.Windows(1).Zoom (srfZoomPage)

FL$ = "RKTML"

DDIRD$ = "F:\@-IK-Training\Modul-08-RKTML\3-Hasil_Grid_Surfer\"
DDIRH$ = "F:\@-IK-Training\Modul-08-RKTML\4-Hasil_Ekstrak_Grid_5_Lok\"

FLO$ = DDIRD$ + "RKTML_All.grd"

'BATAS WILAYAH
SurferApp.GridExtract(InGrid:=FLO$, r1:=705, r2:=749, c1:=534, c2:=581, _
OutGrid:=DDIRH$ + "Tg-" + FL$ + ".txt", _
OutFmt:=srfGridFmtXYZ)
Set doc = SurferApp.Documents.Open(Filename:=DDIRH$ + "Tg-" + FL$ + ".txt")
doc.SaveAs(FileName:=DDIRH$ + "Tg-" + FL$ +
".txt",FileFormat:=srfSaveFormatDat,Options:="Delimiter=comma;TextQualifier=none")
doc.Close(SaveChanges:=srfSaveChangesNo)
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End Sub

IX. Program to Determine the Nearest Distance to Coastline Cell Using Macro
Excel

Sub Main()

Dim DDIRK$, DDIRD$, NM$, HBJR$, HLNT$, HDDD$, T$, PAR$, KLOK$, KCVI$
Dim I, JD, JJ, J, DJRK, DBJR, DLNT, JRK
Dim IKKAB$(100), INKAB$(100), IKSEL$(100), IXX(100), IYY(100), DIXX$(100), DIYY$(100),
IKLOK$(100), IKCVI$(100)

T$ = Chr(9)

DDIRK$ = "F:\@-IK-Training\Modul-08-RKTML\4-Hasil_Ekstrak_Grid_5_Lok\"
DDIRD$ = "F:\@-IK-Training\Modul-08-RKTML\5-Hasil_Running_Jarak_Min\"
DDIRID$ = "F:\@-IK-Training\Modul-08-RKTML\ID_Lok\"

For I = 1 To 5
If I = 1 Then NM$ = "BK"
If I = 2 Then NM$ = "JK"
If I = 3 Then NM$ = "PK"
If I = 4 Then NM$ = "SB"
If I = 5 Then NM$ = "TG"

Open DDIRID$ + NM$ + "_ID.TXT" For Input As 1
JD = 0
Line Input #1, PAR$
While Not EOF(1)
JD = JD + 1
Input #1, XX$, YY$, KLOK$, KCVI$, KKAB$, NKAB$, KSEL$
IKKAB$(JD) = KKAB$
INKAB$(JD) = NKAB$
IKSEL$(JD) = KSEL$
IKLOK$(JD) = KLOK$
IKCVI$(JD) = KCVI$
IXX(JD) = Val(XX$)
DIXX$(JD) = XX$
IYY(JD) = Val(YY$)
DIYY$(JD) = YY$

Wend
JJ = JD
Close #1

Open DDIRD$ + "J-" + NM$ + "-RKTML.TXT" For Output As #2
Print #2, "BUJUR" + T$ + "LINTANG" + T$ + "LOKASI" + T$ + "KODE_CVI" + T$ +

"KODE_KAB" + T$ + "NAMA_KAB" + T$ + "KODE_SEL" + T$ + "RKTML" + T$ + "D_BUJUR" +
T$ + "D_LINTANG"
For J = 1 To JJ
Open DDIRK$ + NM$ + "-RKTML.TXT" For Input As #1
DJRK = 99999
While Not EOF(1)
Input #1, BJR$, LNT$, DDD$
DBJR = Val(BJR$)
DLNT = Val(LNT$)
JRK = Sqr(((DBJR - IXX(J)) ^ 2) + ((DLNT - IYY(J)) ^ 2))
If JRK < DJRK Then
DJRK = JRK
HBJR$ = Trim(BJR$)
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HLNT$ = Trim(LNT$)
HDDD$ = Trim(DDD$)
End If

Wend
Print #2, DIXX$(J) + T$ + DIYY$(J) + T$ + IKLOK$(J) + T$ + IKCVI$(J) + T$ + IKKAB$(J) + T$ +

INKAB$(J) + T$ + IKSEL$(J) + T$ + HDDD$ + T$ + HBJR$ + T$ + HLNT$
Close #1
Next J
Close #2

Next I

End Sub
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I. INTRODUCTION

Tide is one of the parameters used to determination of coastal vulnerability index,

which information about vertical difference between high tide and low tide is called the

tidal range that contribute to coastal inundation hazard. Coastal which have a high tidal

range generally have a low vulnerability to impact of inundation because sea level rise.

Information about the tides can be obtained through measurements on the field or

using the tidal prediction. Along with the improvement of science and technology, so

information about the tide can be obtained via the internet in the form of real-time data or

model result. Based on the periodic characteristic nowadays sea surface level because

tides can be predicted / modeled more accurately in the long time range, so the highest

range of tidal can be known.

More information about sea surface level can be accessed from

http://uhslc.soest.hawaii.edu/uhslc/data.html which produced by Joint Archive for Sea

Level (JASL), the official of JASL now is Global Sea Level Observing System (GLOSS)

data center. In Indonesia BAKOSURTANAL became contributor of this data. The other

information about sea level can be accessed from http://www.ioc-

sealevelmonitoring.org/list.php which is global monitoring station services for

measurement of real time sea surface. These service are part of the IOC programme

consist of (i) the Global Sea Level Observing System Core Network; dan (ii) the networks

under the regional tsunami warning systems in the Indian Ocean (IOTWS), North East

Atlantic & Mediterranean (NEAMTWS), Pacific (PTWS) and the Caribbean (CARIBE-

EWS). In Indonesia contributor of data is BAKOSURTANAL where there are 19 stations

scattered in the Indonesian seas.

In this training module, tidal information obtained through the prediction with the

tide prediction model global NAOTIDE which is assimilation from TOPEX/POSEIDON

data and global and regional model around of Japan. This model was developed by

Matsumoto, K., T. Takanezawa, and M. Ooe and run with the FORTRAN software.

II. OBJECTIVE

The objective of this module is each of participant is be able to prediction and

integrate tidal data to determination of Coastal Vulnerability Index (CVI).
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III. DATA PROCESSING STEPS

Tide prediction begins with search the central point coordinate of the cell that we

created earlier. The central point will be input in the tidal prediction using NAOTIDE.

After getting the central point of the cell, NAOTIDE will be running on FORTRAN

software. In this program you only needs to changed coordinates the place to had tide

prediction (center point of cell), time prediction, and output file name from this program.

After running, the result of this program will be printed on the file that had been definite

early. The result of prediction is hourly sea level, then to obtain the tidal range we

calculate the difference between the highest water level (high water) and lowest (low

water). The overall result of this process is made in a table that will serve as input in the

data integration in GIS process. The steps of general processing data can be seen in

Figure 1.

Figure 1. Flowchart tide prediction data

Central Point of Cell

FORTRAN (NAOTIDE)

Change the time prediction,
place prediction coordinate,

dan output file

Tidal range
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IV. TIDAL PREDICTION USING NAOTIDE

1. Before predict the tide in a place, we must determine center point of cell was made

early, because input to prediction the tidal is coordinate of the point.

Coordinate of the point to be searched the tidal can be seen in D:\@-IK-

Training\Modul-05-RKPS\1-ID_Sel\Point_Tide_Tg.txt

2. Open fortran powerstation 4.0 software Microsoft Developer Studio

3. Choose open ( ) then choose directory where we save the folder naotide (D:\@-

IK-Training\Modul-05-

KPS\naotide(Heron))

After that, then will appear three choices after we choose naotide, (nao2xyap.f,

naotest.f, naotide.f) then we choose naotest.f.
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4. Then will appear listing program from that file, we only have to change tide

prediction time, tide coordinate and output file name.

 Change tide prediction time

 Change tide coordinate

 Change output file name

Function of this program is change the output file name

Output file name
outfile = 'TideTg1.out'

Function of this program is change the station of tidal

Station location
x = 106.397991d0 ! East longitude in degree
y = -6.007711d0 ! North latitude in degree

Function of this program is change the end of prediction time.

End epoch
iyear2 = 2008 ! year
imon2 = 12 ! month
iday2 = 15 ! day
ihour2 = 0 ! hour
imin2 = 0 ! minute

Function of this program is change the of start prediction time.

Start epoch
iyear1 = 2008 ! year
imon1 = 12 ! month
iday1 = 1 ! day
ihour1 = 0 ! hour
imin1 = 0 ! minute
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5. After all that we change, choose compile then after the compile ( ) done choose

build ( ). After build is done choose sign go ( ) to running the raw program.

Then will appear the running program.

6. Then, open the result program file. For example, if we saved the file with name

TideTg1.out then open the file in D:\@-IK-Training\Modul-05-

RKPS\naotide(Heron)

7. Open the file in Microsoft excel to see the result, the naotide program has format like

in Table 1, the part in color yellow shows the tide prediction in that coordinate. The

last result from tide prediction is tidal range. Tidal range is get from highest tide

(HW) minus lowest tide (LW).

Where

KP = Tidal range

Maks.L = Maximum value of sea level

Min.L = Minimum value of sea level
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Table 1. Sample output tidal prediction with NAOTIDE program

Grafik Ramalan Pasang Surut Stasiun Sabang
(Tanggal : 1 - 30 April 2007 Posisi : 95.30º BT dan 5.90º LU)

MSL = 90 cm

LW = 1 cm

HW = 177 cm
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Figure 3. Sample of visualitation data tidal prediction in 1 – 30 April 2007 at

Sabang station.

Geocentric tidal height

Elapsed day Tide(cm) Short-p Long-p M D Yr H M MJD Longitude Latitude

0 21.802 24.51 -2.708 12/ 1 2008 0:00 0 54801 106.398 -6.0077

0.041667 32.262 34.959 -2.697 12/ 1 2008 1:00 0 54801.04 106.398 -6.0077

0.083333 39.455 42.141 -2.686 12/ 1 2008 2:00 0 54801.08 106.398 -6.0077

0.125 42.662 45.336 -2.674 12/ 1 2008 3:00 0 54801.13 106.398 -6.0077

0.166667 41.748 44.41 -2.662 12/ 1 2008 4:00 0 54801.17 106.398 -6.0077

0.208333 37.153 39.803 -2.649 12/ 1 2008 5:00 0 54801.21 106.398 -6.0077

0.25 29.753 32.39 -2.637 12/ 1 2008 6:00 0 54801.25 106.398 -6.0077

0.291667 20.651 23.275 -2.623 12/ 1 2008 7:00 0 54801.29 106.398 -6.0077

0.333333 10.943 13.552 -2.61 12/ 1 2008 8:00 0 54801.33 106.398 -6.0077

0.375 1.515 4.111 -2.595 12/ 1 2008 9:00 0 54801.38 106.398 -6.0077

0.416667 -7.071 -4.49 -2.581 12/ 1 2008 10:00 0 54801.42 106.398 -6.0077

0.458333 -14.597 -12.031 -2.566 12/ 1 2008 11:00 0 54801.46 106.398 -6.0077
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I. Introduction

Significant wave height is wave tall average (from peak to valley) from one-third

highest sea wave. In coastal vulnerability, the significant wave height becomes a

parameter related to the coastal inundation hazard. Utilization of this wave of data given

the severe lack of data on a national scale waves in the waters of Indonesia.. Given

there are rarely observed wave data in situ, so it requires data derived from satellite

altimetry.

Significant wave height data derived from ECMWF (European Centre for

Medium-Range Weather Forecasts) can be downloaded from http://ecmwf.int/.

Processing method is a reanalysis of the data used, and the assimilation model

(numerical weather prediction) satellite and in situ data. This organization provides a

medium-long term forecasting for the data's atmosphere / weather, and super-computing

facilities for scientific research and the scientific and technical cooperation with the

satellite agency and the European Commission. ECMWF is also a result of the

development of dynamic and synoptic meteorology more than 100 years and more than

50 years of development in numerical weather prediction (Numerical Weather

Prediction). ECMWF forecasting system consists of general circulation models, ocean

wave models, data assimilation systems and since 1992 an ensemble forecasting

system. In 1998 the seasonal forecasting system started operation and in 2002

introduced a monthly forecasting system.

II. OBJECTIVE

The objective of this module is for each participant is able to do the acquisition,

processing and integration of significant wave height data for the determination of

Coastal Vulnerability Index.
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III. Data Acquisition

1. Data acquisition from http://ecmwf.int/, will emerge as follows:

2. On part Hot links sectioned click Data so will emerge as follows:

3. Click The ECMWF Research Data Server for publicly available data for research

use , will emerge as follows:
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Click Retrieve data from the ECMWF Interim Re-Analysis to get present year

presage data, and appears appearance as follows:

4. Select for desirable time gyration, better elective, data that produced not too big

and easy accustommed in data group so that make easy in processing.

5. Hereafter on page same elective the time of day and step is desirable time as on

following appearance:

6. Select for parameter one that will be utilized, as follows:
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7. Select for parameter which will be utilized deep this study data which is utilized is

Significant wave height. Then press conditions of use present under.

8. Then input on sheet as hereunder, insert you information and click Accept.

Then screen look will return to sheet that early, and reenacts as upon. Then press

at down section page.

9. Succeeding sheet as on figure under this!

click to choose area, a part one upstairsing to constitute data information that will

be chosen, if has accorded click area Now therefore succeeding will see

appearance as follows:
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Click custom to make area bases particular coordinate, afterwards will emerge

appearance as follows:

insert limit coordinate area and name area, necessary payed that in longitude sign

(-) longitude west and (+) longitude east, furthermore in latitude sign (-) latitude

south and (+) latitude north. Click so area and name appearance corresponds to

coordinate already be inserted. Better we choose wider area (all Indonesia) that

we ifrequently do Download.

10. Click Now to download areas appropriate data already be made, and its

appearance as follows: then click nc to begin download.
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IV. Data Processing

Data processing average Significant wave height started by extracts data get netcdf

format(*. nc) by use of ODV (Ocean Data View) into data formatted text format(*.txt) in a

wider area from desirable bounds. Further data at intervals of 6 hours of it each year are

averaged and the result is the average annual significant wave height. For the purposes

of more detailed information as input in a cell at the beach then performed to measure

spatial interpolation grid using the surfer into 1 km x 1 km. Then the interpolation results

are further cut to the desired area and exported into XYZ format data using Global

Mapper. The next step sought the position closest to the cell position on the beach using

Surfer

The data processing step can be viewed in a systematic way in Figure 1 below.
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Significant
Wave Height

(ECMWF)

Ocean Data View :
1. Read Data Format
2. Cropping Data
3. Export Data

Surfer :
1. Interpolation
2. Eksport Data

Global Mapper :
1. Cropping Data
2. Eksport Data

Surfer :
1. Overlay with Coastal Cell
2. Digitation

Program 2 with
Surfer Scripter:
1. Read Data Format
2. Cropping Data
3. Export Data

Program 3 with
Macro Excel:
1. Read Data Format
2. Cropping Data
3. Export Data

Method 1Method 2

ID Location
(Position of center
coastal cell)

Surfer :
1. Interpolation
2. Eksport Data Output

to GIS

Output
to GIS

MS. Excel :
Averaging

Program 1 with
Macro Excel:
Averaging data (every 6-
hour to yearly)

Figure 1. Process Flow Chart of Significant Wave Height Data Acquisition Value to
Nearest with cells Coastal.

V. Extract Data Significant Wave Height Netcdf's format (*.nc) with Ocean View's
Data (ODV)

1. Data processing average significant wave height already being downloaded started

by extracts data get format NetCdf (*. nc) by use of ODV (Ocean is View's Data) as

data gets text format(*. txt). Earlier we open at ODV'S software( Ocean is View's

Data ). Then chooses File > open data already saved.
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2. Will appear as shown below, then click on the longitude of the left while pressing

Ctrl and click all the variables until all blocked. Then press Next.

3. Next's click > since all variable that exists on sheet self acting data have most

associate with proprietary variable by ODV.

4. Select Use the dummy variable for the data extracted in the format * txt based on

sequence data distribution, but if we choose use decimal date (header) data is

extracted in the format * txt in the order in each station.

5. Select for into zoom to cropplng data bases region who will be utilized. Then finish.
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6. Cropping region which will be utilized on this sheet by click outboard right map then

select for properties's windows > map.

7. So it looks like the following view, select the domain based on the area to be, on

the border area coordinat 0.5 o LS – 12.5 o LS and 101.5 o BT – 118.5 o BT, and

press Ok.
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10. To export data to *txt format by export's press at up section then select for ODV is

spreadsheet . Save file on folder \2 Data_Eksport_ODV, then press save.

VI. Average Significant Wave Height Data with Interval 6 Hours of Being
Average Annual use MS Macro Excel

1. Hereafter data with interval 6 hour is flattened annual and its result as average as

significant wave height annual. Earlier we open data already most format deep
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extract *txt at Microscoft Excel, drawned out by data selection, data who will be

utilized which is longitude, latitude and Significant wave height. Before we begin

average earlier we sort data a station by undertaking instruction Sorting & Filter

data on job sheet excel , by obstructs all beforehand data, click Sorting & Filter >

Custom is Sorting > add is level > by's sorting (Column A) > Then by (Column

b) as looked as on figure as follows:

2. Data already most massage bases our station dot average up to annual. Hasten

average data, we do at Macro is Excel's Visual Basic by, earlier we input data entry

into display Microsoft excel where is column A. as Longitude column B as Latitude

and column C as significant wave height then that data we save in format *csv

(comma delimited ) after at save sheet excel doesn't be closed, can we see on

figure as follows:
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3. After data was save by us click command View> Macros click chooses Record

Macros.

4. Will Appear as below click OK.

5. Then click View > Macros > select for Recording's stop.

6. Click View again then click Macros > select for View Macros.

So that would appear like the following figure:
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7. Click Edit, so that the display appears as follows::

8. On sheet Microscoft is Visual Basic we insert to program already we make, can we

see hereunder, after programs to be inserted changes directory the then total data

who will be divided. Hereafter we begin to click Run ( ).
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Row formation programs as follows:

Sub Macro1()

DDIR$ = "D:\@-IK-Training_6\3-Hasil_Seleksi_Lok\"

Open DDIR$ + "Rata-rata-pertahun.csv" For Input As #1
Open DDIR$ + "Rata-rata-pertahun.txt" For Output As #2

While Not EOF(1)
JSWH = 0
For I = 1 To 1460
Input #1, LON, LAT, SWH
JSWH = JSWH + SWH
If I = 3 Then
DLON = LON
DLAT = LAT

End If
Next I

RSWH = JSWH / 1460

Write #2, DLON, DLAT, RSWH

Wend

Close #2
Close #1

End Sub

VII. Interpolation Using Data Grid With Surfer
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1. Data already annual therefore done by spasial grid's interpolating until measure

becomes 1 km x 1 km by use of software Surfer as stationary as information which

more detail as entry in cell at coast.

2. Earlier we open data already most *txt format extract at Surfer. Sort that data on

job sheet worksheet by File > New vote for Worksheet , data who will be utilized

which is longitude, latitude and Significant wave height. Where is column A is

longitude , column B is latitude and column C is Significant wave height. After data

most selection then save in *DAT's format on folder \3 Hasil_Seleksi_Lok.

3. Data already *DAT format then at interpolating by job sheet open Surfer click File

vote for New Plot. After job sheet emerges then utilize instruction Grid > select for

data. So gets visually figure as follows:
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So that the display will appear as follows:

4. Select for x as A column, y. as column B and z as column C, to Gridding method

we utilize Kriging , Output Grid is file for file address that will at save. Grid line

Geometry we only just substitute Spacing with spasial grid's measure becomes 1

km x 1 km because of in form degree we change to go to decimal degree with

point Spacing 0. 009090909091 x 0.009090909091, after all filled click OK.



115

VIII. Cropping Area Boundary and Data Export with Global Mapper

1. After processes Kriging all through then drawned out by conversion Grid into

ASCII format (xyz) with cropping region who will be utilized, by opens grid's result

at programs Global mapper. Its trick is open Mapper Is global > Open Your Owen

Data Files > So get as been see figure as follows:

Will emerge as follows, click OK.

After data is opened then click File > Eksport Raster File and Elevasion Data >

Export XYZ Grid > OK.
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Will appear as below: Click the Export Bounds

Change Lat / Lon, Global Projection, Corner w/size-Global Project with coordinate

bounds that at wants to correspond to domain watch region. Let say domain

observing Tanggerang region by fills North -5.695 South -6.1 West 106.345 East

106.763 Then pressing OK and Save is file in *txt format.
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IX. Find The Nearest Point of Significant Wave Height on on Central Coastline
Cell

1. The next step sought significant wave height is the position closest to the position

of cells in the coast for annual with an overlay to the cell data with the data point of

the wave, using the software Surfer. Open Surfer> (to open a significant wave

height data point) Map> New> Folder Post> Post to regulate Properties click on

Post dabel Map.

2. To open a data cell by selecting File> Import> Open file data cell. Can we look like

the following figure:

3. To be able to see the point of our stations can use the Digitize command by

clicking the Folder> Digitize, then click on the station nearest point on the cell

spacing. Having to point the coordinates of significant wave height with the shortest
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distance, then enter the value of significant wave height and depth coordinates of

integration cell format, can dilhat on the following figure:
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X. The program extracts, cropping, and Significant Wave Height Data Export
Once interpolated With Surfer

1. Open the software Surfer Scripter can be seen in the figure below:

So it can appear like the figure below:

2. Enter the program lines Prog-Seleksi_GRD_Ekstrak_Lok on the scrip sheet that

has been made: change the directory and then Run ( )
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Line program

Sub Main()

Dim JN, PX, PY, PZ, BA, BB, BL, BR, SP, XCL, YCL, JD, Z, I, PJ, L, DBJR,
DLNT
Dim T$, S$, DDIRD$, DDIRH$, FL$, CK$, PAR$, TBJR$, TLNT$, TPAR$, FLI$,
FLO$
Dim DT$(25)

' MASUKAN JUMLAH KOLOM DATA
JN = 10
JN = JN - 1
' MASUKAN KOLOM X (BUJUR)
PX = 6
' MASUKAN KOLOM Y (LINTANG)
PY = 7
' MASUKAN KOLOM Z (PARAMETER)
PZ = 9
' MASUKAN KOORDINAT BATAS ATAS
BA = -0.5
' MASUKAN KOORDINAT BATAS BAWAH
BB = -12.5
' MASUKAN KOORDINAT BATAS KIRI
BL = 101.5
' MASUKAN KOORDINAT BATAS KANAN
BR = 118.5

' MASUKAN SPACING GRID
SP = 0.009090909091
' MASUKAN JUMLAH KOLOM-X GRID
XCL = 1871
' MASUKAN JUMLAH BARIS-Y GRID
YCL = 1321

T$ = Chr(9)
S$ = ","

DDIRD$ = "D:\@-IK-Training\Modul-06-Gelombang\2-Data_Eksport_ODV\"
DDIRF$ = "D:\@-IK-Training\Modul-06-Gelombang\3-Hasil_Seleksi_Lok\"
DDIRG$ = "D:\@-IK-Training\Modul-06-Gelombang\4-Hasil_Grid_Surfer\"
DDIRH$ = "D:\@-IK-Training\Modul-06-Gelombang\5-
Hasil_Ekstrak_Grid_Global_mapper\"

' SETTING SURFER
On Error Resume Next 'Turn off error reporting.
Set SurferApp = GetObject(, "Surfer.Application")
If Err.Number <> 0 Then
Set SurferApp = CreateObject("Surfer.Application")

End If
On Error GoTo 0 'Turn on error reporting.
If SurferApp.Windows.Count = 0 Then SurferApp.Documents.Add (srfDocPlot)
SurferApp.Visible = True
SurferApp.WindowState = srfWindowStateNormal
SurferApp.Width = 1024
SurferApp.Height = 200
SurferApp.Windows(1).Zoom (srfZoomPage)

For Z = 1998 To 1998
FL$ = Trim(Str(Z))
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Open DDIRD$ + "data_from_" + FL$ + ".txt" For Input As #1
Open DDIRF$ + FL$ + ".dat" For Output As #2

While Not EOF(1)
Line Input #1, PAR$
CK$ = Mid$(PAR$, 1, 2)

If CK$ = "Cr" Then
CK$ = "//"

End If

If CK$ <> "//" Then
For I = 1 To JN
PJ = Len(PAR$)
L = InStr(1, PAR$, T$)
DT$(I) = Mid$(PAR$, 1, L - 1)
PAR$ = Mid$(PAR$, L + 1, PJ - L)
If I = JN Then DT$(I + 1) = PAR$

Next I

TBJR$ = DT$(PX)
TLNT$ = DT$(PY)
TPAR$ = DT$(PZ)
DBJR = Val(DT$(PX))
DLNT = Val(DT$(PY))

If DBJR >= BL And DBJR <= BR And DLNT >= BB And DLNT <= BA And TPAR$
<> "-99.99" Then

Print #2, TBJR$ + T$ + TLNT$ + T$ + TPAR$
End If

End If 'CK$

Wend 'LOAD DATA
Close #2
Close #1

FLI$ = DDIRF$ + FL$ + ".DAT"
FLO$ = DDIRG$ + FL$ + ".GRD"

'GRIDING
SurferApp.GridData(DataFile:=FLI$, xCol:=1, yCol:=2, zCol:=3,

ShowReport:= False, _
DupMethod:=srfDupAvg, NumCols:=XCL, NumRows:=YCL, xMin:=BL, xMax:=BR,

yMin:=BB, yMax:=BA, _
Algorithm:=srfKriging, OutGrid:=FLO$, OutFmt:=srfGridFmtS7)

'BATAS TANGERANG
SurferApp.GridExtract(InGrid:=FLO$, r1:=705, r2:=749, c1:=534, c2:=581,

_
OutGrid:=DDIRT$ + "Tg-" + FL$ + ".txt", _
OutFmt:=srfGridFmtXYZ)
Set doc = SurferApp.Documents.Open(Filename:=DDIRT$ + "Tg-" + FL$ +

".txt")
doc.SaveAs(FileName:=DDIRH$ + "Tg-" + FL$ +

".txt",FileFormat:=srfSaveFormatDat,Options:="Delimiter=comma;TextQualif
ier=none")
doc.Close(SaveChanges:=srfSaveChangesNo)

Next Z
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End Sub

XI. Determining the Shortest Results with Microsoft Visual Basic Language

1. Open program Microsoft Excel, choose View > click Macros > select Record

Macros.

Record Macros so that its display appears as shown in the figure below: and click

Ok.

2. Choose again View > Macros > Select Stop Recording.

3. To display the Microsoft visual basic screen us choose again the command View>

Macros> View Macros.

Macro display will appear:
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4. Then click Edit, and the screen will display the Microsoft Visual Basic as the

following figure.

5. Then line program we've created, we put on the sheet visual basic.
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Then change the file directory, then run the program by clicking on the RUN icon

( )

Program line following:

Sub Main()

Dim DDIRK$, DDIRD$, NM$, HBJR$, HLNT$, HDDD$, T$, PAR$, KLOK$, KCVI$,
TH$
Dim I, JD, JJ, J, DJRK, DBJR, DLNT, JRK
Dim IKKAB$(100), INKAB$(100), IKSEL$(100), IXX(100), IYY(100),
DIXX$(100), DIYY$(100), IKLOK$(100), IKCVI$(100)

T$ = Chr(9)

DDIRK$ = "D:\@-IK-Training\Modul-06-Gelombang\ID_Lok\"
DDIRD$ = "D:\@-IK-Training\Modul-06-Gelombang\5-
Hasil_Ekstrak_Grid_Global_mapper\"
DDIRS$ = "D:\@-IK-Training\Modul-06-Gelombang\6-Hasil_Jarak_Min\"

For I = 5 To 5
If I = 1 Then NM$ = "BK"
If I = 2 Then NM$ = "JK"
If I = 3 Then NM$ = "PK"
If I = 4 Then NM$ = "SB"
If I = 5 Then NM$ = "TG"

Open DDIRK$ + NM$ + "_ID.TXT" For Input As 1
JD = 0
Line Input #1, PAR$
While Not EOF(1)
JD = JD + 1
Input #1, XX$, YY$, KLOK$, KCVI$, KKAB$, NKAB$, KSEL$
IKKAB$(JD) = KKAB$
INKAB$(JD) = NKAB$
IKSEL$(JD) = KSEL$
IKLOK$(JD) = KLOK$
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IKCVI$(JD) = KCVI$
IXX(JD) = Val(XX$)
DIXX$(JD) = XX$
IYY(JD) = Val(YY$)
DIYY$(JD) = YY$

Wend
JJ = JD
Close #1

Open DDIRS$ + "J-" + NM$ + "-RTGL.TXT" For Output As #2
Print #2, "BUJUR" + T$ + "LINTANG" + T$ + "LOKASI" + T$ + "KODE_CVI" +

T$ + "KODE_KAB" + T$ + "NAMA_KAB" + T$ + "KODE_SEL" + T$ + "TAHUN" + T$
+ "SLT" + T$ + "D_BUJUR" + T$ + "D_LINTANG"

For K = 1998 To 1998
TH$ = Trim(Str(K))
For J = 1 To JJ
Open DDIRD$ + NM$ + "-" + TH$ + ".TXT" For Input As #1
DJRK = 99999
While Not EOF(1)
Input #1, BJR$, LNT$, DDD$
DBJR = Val(BJR$)
DLNT = Val(LNT$)
JRK = Sqr(((DBJR - IXX(J)) ^ 2) + ((DLNT - IYY(J)) ^ 2))
If JRK < DJRK Then
DJRK = JRK
HBJR$ = Trim(BJR$)
HLNT$ = Trim(LNT$)
HDDD$ = Trim(DDD$)

End If
Wend
Print #2, DIXX$(J) + T$ + DIYY$(J) + T$ + IKLOK$(J) + T$ + IKCVI$(J)

+ T$ + IKKAB$(J) + T$ + INKAB$(J) + T$ + IKSEL$(J) + T$ + TH$ + T$ +
HDDD$ + T$ + HBJR$ + T$ + HLNT$

Close #1
Next J

Next K

Close #2

Next I

End Sub
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I. Introduction

The elevation or coastal slope is one of parameters for determining coastal

vulnerability index. The important of elevation data in coastal area relating with estimate

the flooding area causes sea level rise. Understanding information of elevation an area, it

can be predicted the area will be flood due the rising sea level rise.

There are many ways in the present elevation of the earth's surface in digital. One

way to present the earth's surface with a limited storage capacity is the Digital Elevation

Model (DEM). DEM is a model to describe the topography of the earth's surface so it

can be visualized in 3D (three dimensional). There are many way to obtain DEM data,

Interferometric SAR (Synthetic Aperture Radar) is new algorithm to create a new DEM

data. Image data from SAR or radar images used in the process of interferometry can

be obtained from satellite or plane rides, other from the radar DEM can also be obtained

from the ASTER. In this training will be used for DEM data is GDEM (Global Digital

Elevation Model) derived from satellite ASTER (Advanced Spaceborne Thermal

Emission and Reflection Radiometer).

GDEM has the accuracy (spatial resolution) are pretty good that is 30 meters, while

the coverage area is nearly the entire surface of the earth. GDEM data can be

downloaded on http://www.gdem.aster.ersdac.or.jp, which released the data format is

TIF (Tag Image Format) which can be opened directly in GIS software, making it easier

for purposes of further analysis.

I. Objective

The objective of this module is to provide guidance how to obtain DEM data by

downloading from the internet and to determination coastal slope value from DEM data

by using GIS software.
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II. Coastal Area

The term of beach or coastal areas are often known as an interplay between land

and sea, which has special characteristics geosphere, landward restricted by the

physical properties of marine and nautical socioeconomic, while the direction to sea is

bordered by natural processes and due to human activity of the land environment.

Coastal is a system between the oceans and land have relationship each other. How

much land affect to the ocean and how far ocean affect to the mainland, it's all a system

of coastal states. Coastal system can be describe like Figue 1.

Figure 1. Coastal system.

Coastal area is a zones which varies in width, which covers the shore which extends

towards the mainland to the limit of marine influence is still felt. Basic classification of

coastal is change shoreline to forward and backward. Change shoreline to forward can

be caused by the removal of coastal or deposition by progradation, while backward

caused by coastal erosion sink or retrogradation.

Coastal environment is an area that is always to be change, because the area

became a meeting place of two forces, which is from land and from sea. Coastal

environmental changes can occur slowly or very fast, depending on the power balance

between topography, rocks, and its properties with waves, tides and wind. Coastal

change varies greatly from one place to other place, so the spatial study of coastal

environments is required in order to manage the coastal environment. Coastal
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environment to be managed properly considering the function in human life is very large

since antiquity to the present and even future.

III. Data Aquisition

Generally, there are three main step to obtaining DEM data from internet, namely

the registration as member, select the desired area, the latter is the process of

downloading data. This is detail step by step to obtaining data :

1. Type website address into the address bar http://www.gdem.aster.ersdac.or.jp, in

which case we are using Mozilla Firefox, then press enter.

2. If your computer is connected to the internet it will show a web page as follows

3. Click register & modification menu to login then you will enter in personal data form

filling page.
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4. Fill the form in accordance with his orders, that marked with an asterisk (*) is a sign of

the command fields are mandatory  After filling the form is completed click the Next

button  if registration is successful then you will return to the main page and means

registration is successful, and your user name will be show on the side upper right

corner.

5. Next click search menu to start searching DEM data  you will go to the page map as

follows :
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6. With help of a computer mouse zoom the area you want to download  in this case

we will zoom Tangerang area.

7. Before you are downloading data you must first choose any location that you will

download  Chose select tiles directly menu then click start menu  then cursor

will change shape like a plus sign (plus) then click the area you want, in this case

we choose the Tangerang region.
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8. After your location have been selected  then click next menu the data will be

show and ready to download

9. After the data has been show  click next menu, then you will enter to agreement

page  in select purpose menu chose climate according to your needs)  then click

Agree then you will in the download page
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10. In this page file ready to download, there are two way to download file, that is

download file one by one or download all file directly  In this exercise we will

download files at onceclick download menu to obtaining data

11. The next process there will be rendering data  after rendering data finished 

then you will be asking directory to save file  save file data at your computer
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12. Wait saving process until complete  if downloaded file is complete, the download

process or completion of data acquisition is done.
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IV. Data Processing

In the DEM data processing there are two software that is used for processing, namely

the Global Mapper and ArcGIS 9.2 is substituted, equipped with Hawths Analysis Tools.

In general there are several steps in the processing of DEM data, such as reading data,

crooping data, extraction of data, reading data into ArcGIS, the search slope, Grid

statistical each cell, the integration of data into GIS. The following step is complete in

data processing :

a. Reading of data

GDEM (Global Digital Elevation Model) data downloaded from the Internet are formatted

"zip" and consists of several files, to open and combine files we will use the Global

Mapper software. Here are the steps the reading process, merging, and export data in

Global Mapper

1. Open program global mapper at your computer start program global mapper

 then you will be enter to following page global mapper

2. Open your file GDEM data fileopen data file(s)  locate the data files on your

data storage directory (D: \ @-IK-Training \ Module-7-DEM \ 1_Data_asli)  Select

the file you want to open (press the CTRL key on your keyboard to select more than

one data file)  click open menu  click yes all when there is a warning window on

the Global Mapper Wait a moment, then the file will open
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3. You will see file that is open GDEM, Next..there are some configuration to choose

the data, that is  choose tool menu  Control Center Unchecklist all file “NUM”

cause we are not to use it  click option at the window elevation option choose

alter elevation values  make sure unit is meters  make sure minimum valid

elevation have zero value click OKthen click close menu to close windows

4. After configuration is finished, the next step is export data as you want  click file 

export raster and elevation data  export DEM  on Windows DEM Export Option

choose export bounds set the coordinates of the area you want, in this training we

will download the Tangerang area with boundary coordinates 106 345 BT - BT 106

767 and LS 5695 - 6:15 LS  save the file in your directory (D: \ @-IK-Training \

Module-7-DEM \ 3_Data_hasil_olahan) give the name of the file to your liking Wait

the process till 100% export data export process is complete
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b. Data Analysis in ArcGIS

In the ArcGis program data will be analysis to determine slope value according grid has

been made before in exercise introduction GIS. The slope value that taken just inside in

the grid, because in one grid there are a lot of slope values, then the value is in one grid

were averaged to obtain one value in a single grid. Completely steps is following

1. Open your Arcgis programstart program  Arcgis ArcMap set your

projection system with coordinat geographic and WGS84 system

2. Before opening the DEM file results from Global Mapper first activate the layer of

fgrid that have been made previously, in this exercise I use the grid Tangerang area

with the number of grid 51. These grid will function as a cutter (crooper) slope

values within the grid. Way to open that layer is click add data  search the

directory layer of grid on your computer, in this exercise are the grid files in the
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directory D: \ @-IK-Training \ Module-7-DEM \ 2_Data_Peta \ sel  choose

clip_elevasi_geo_tangerang.shp click add

3. After the grid layer is active then open DEM file that produced from Global Mapper 

add data search file in your directory computer, in this exercise files are located

in the directory D: \ @-IK-Training \ Module-7-DEM \ 3_Data_hasil_olahan select a

file gabungan.dem click add  then there are two layer active, that is grid layer

and DEM layer are like the following :
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4. The next step is to determine slope value of the composite layer. Before starting the

determination of the slope value. Make sure the 3D analyst toolbar and the Hawth's

tools in an active state Select View menuToolbars

5. Determining the slope value is ready to made select 3d analyst menu surface

analyst select slope

6. After you selecred slope menu you will enter at the page configuration slope  make

sure input surface : gabungan.dem (or another raster file)  select output
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measurement as percent  Z factor : 0.00000899281 output cell size let default

value save file in your directory computer

information :

 Output measurement : percent  is a unit of the slope in percent. The

concept of unit slope are expressed as percent on the following figure:
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 Z faktor  is a unit adjustment factor, because the unit value of Z (elevation)

is the meter shall be adjusted to the unit coordinate system of degrees. Z

factor value is 1, assuming the value of 1o is 111.2 km, the 1 meter equal to

0.00000899281o

7. Wait few moments to complete the process of forming the slope, after the process is

finished slope will automatically appear as a new layer in ArcGIS as follows:

8. The next process is to take (crooping) slope value which resides in the grid by using

the Hawth's tools. This tool able to average value in one grid, so that at the grid only

have one slope value. Select Hawth’s tools menu  Raster tool  Zonal Statistics

(++)
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9. Then you will be asking to determine slope value base on option that available  on

Zonal polygon layer select grid data which serves as the boundary crooping (in this

case we use clip_elevasi_geo_tangerang.shp file)  on the raster layer select the

slope (the slope of the layer formation process results)  select the output table

name according to your liking saveok

10. Wait until the process crooping is complete. After finished make sure that cropping

process succed and have logic value. File that produced have format “dbf” so we

can open this file with Arcgis as directly. The values are the result crooping minimum

value, maximum, average, standard deviation, and the number in each cell, because
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grid used was 51 so rows of data that comes out is also numbered 51. In this training

we only require the average value in each grid for the parameter determining coastal

vulnerability index. Here is sample result data cropping

c. Combine data slope value in grid

The process of incorporation is a step which the slope value (slope) is inserted into the

attributes of cells for analysis GIS. This process is quite easy because only do the join

table only. The steps are as follows

1. Make sure at the Arcgis there are two layer has been active, that is grid layer and

(clip_elevasi_geo_tangerang) and slope layer (crooping_slope)

2. Because of this training we only require the average value of the slope in each cell

then delete the values that are not necessary, as a minimum, maximum, standard

deviation  Step-by-step to removal is  right click at the crooping_layer slope 

open after the table is active right click on the header data delete field
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3. After processing delete data are finished  then processing join table has ready 

right click on clip_elevasi_geo_tangerang layer  join and relates select join

4. Next, you'll go to the menu choices in the join table as follows:
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Customize options such as figure above

5. Processing of join has been finished  samples of the join is as follows:
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I. Introduction

Changes in shoreline is one of the parameters used in the determination of

Coastal Vulnerability Index. The beach is a zone that is dynamic because it is

a zone of intersection and interaction between air, land and sea. The coastal

zone continues to experience ongoing adjustment process leading to a

natural balance to the impact of external and internal influences both natural

and human intervention. Natural factors such as waves, currents, tides, wind

action, climate, and tectonic and volcanic activity. While the activity of human

intervention is the use of coastal areas such as industry, fisheries, ports,

mining and settlement. That the coastal shoreline change of the coastal

region was declared vulnerable.

Shoreline change can be divided into positive and negative changes.

Positive change is if the process of sedimentation occurred in the coastal

region. So in coastal areas that experienced positive changes, will

experience the addition of coastline towards the sea. While the negative

changes in case of abrasion on coastal processes, so that the coastline will

retreat toward the mainland. Shoreline change can be determined through

satellite imagery or a mathematical model based on the proportion of coastal

sediments. In this activity data used to identify variables shoreline change

obtained from the SPOT image in 2003 as an information and 2008 shoreline

early as the end of the shoreline information.

II. Objective

• Provide guidance on how to obtain data on changes in the coastline from

satellite imagery

• Provide guidance shoreline change data processing using ArcGIS

software

• Provide guidance in making the data cells to variable shoreline change.
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III. Data Processing

In the data processing rate of shoreline change, we do digitization process

map "shoreline" in the good image of the old year (2003) and new year (2008).

Previously must be ensured that the two images were geometrically corrected

properly..

1. Geometric correction process: open the program ermapper

Select the menu geocoding wizard: Process> geocoding wizard. There will be

five steps to perform the geometric correction process.

a.The first stage of open files that will be corrected (ALOS 2008): at D: \ @-

IK-Training \ Modules-08-LPGP \ Data. Select the type of geocoding

(usually we use polynomial type because the result would be great)
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b.Step two: select the type of polynomial setup.

c. The third stage (GCP Setup): check list Geocoding image, vector, or

algorithm then call the image that has been corrected (ALOS 2003) in D: \

@-IK-Training \ Modules-08-LPGP \ Data \ spot_2003. If the Output

Coordinate Space could tradition is still unknown according to data datum

and projection system. At this time the image of geodetic datum: WGS84

Geodetic projection: SUTM48

Coordinate type: eastings/northings

d. Fourth stage (GCP Edit). At this stage we set where the point to be used

as a point of ground control points. GCP is a point that became clear in the

image and are fixed for example coastal structures.
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At this stage would appear four new windows 2 windows image that has

not been corrected and 2 imagery has been corrected (1 windows is an

overview, so that when closed it does not matter)

To make GCP select which will be created and click on the image that has

not been corrected and that has been corrected in the same location.

Create GCP least 4 so that the RMS value will appear. For geometric

correction try RMS value of less than 0.5 (the smaller, the better the

results)

add GCP

reduce GCP
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GCP values can also be stored , so if we want to perform geometric

correction on the same location but different year, we can call an existing

GCP.

e. The fifth stage (Rectify): At this stage an image rectification phase (storing

the result).
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Cell attributes of the content in accordance with a resolution of satellites

used. The last step is to "save the file and start Rectification"

To view the results and compare between the old with the new image open

image file on the same layer.

Set transparency to see the changes..

Transparency 75% on Alos_2008 image
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2. Open the image data ALOS spot in 2003 and 2008 in D: \ @-IK-Training \

Modules-08-LPGP \ Data

3. Create new feature "shoreline" of type polyline> do the process of digitization

 Create new features such as "shoreline": ArcToolBox> Data Management

Tools> Feature Class> Create Feature Class

 Click the Start Editing want digitized layer

 Then open the Editor Toolbar, then select Create New Task in the Current

Task

 Click the Tool palette and select the Sketch Tool
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Note: Once digitized, the shoreline should be corrected for tidal data.

4. Show data digitized shoreline of old and new in a single layer.

5. Calculating the rate of shoreline change in each cell, by calculating the

difference between the average distance between the old shoreline (spot

2003) with new (ALOS 2008) in each cell.

New costline (2008)

Old costline (2003)
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If the new shoreline (2008) in front of an old coastline (2003) then there is the

process of sedimentation (accretion), in other words the rate of shoreline

change is positive. Conversely if the new shoreline (2008) behind a long

coastline (2003), the abrasion process occurs, in other words the rate of

shoreline change is negative. If the shoreline of old and new means no

changes to the shoreline so that the value of the rate of shoreline change 0.
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6. Results The average annual rate of shoreline change data entered into the

existing cell
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I. Introduction

The value of coastal vulnerability index influenced by six parameter, that is

geomorphology, relative sea level rise, mean tidal range, mean wave height, coastal

slope, and shoreline change. There parameters have constant and dynamic value

changed to time. The parameters which have changed value are geomorphology,

relative sea level, and coastal slope. While the parameters that have a dynamic value

that is mean tidal range, mean wave height, and shoreline changed.

Before get the value of coastal vulnerability index, the sixth parameter values must

be classed into five classes namely class is very low, low, medium, high, and very high.

This process have four cases that will affect the range of classes from the sixth

parameter. The case are west coast, east coast, national and local, but in here will be

discussed only in local cases. Value of coastal vulnerability index can be calculated by

the formula :

Where

a = Class of geomorphology parameter

b = Class of relative sea level rise parameter

c = Class of mean tidal range parameter

d = Class of mean wave height parameter

e = Class of coastal slope parameter

f = Class of shoreline changed parameter

Table1. Coastal Vulnerability Index (Thieler and Hammar-Klose, 2000; USGS).
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Very Low Low Medium High Very High

1 2 3 4 5

Geomorphology -

Rocky, cliffed

coastal,

fjords,

Medium cliffs,

indented

coasts

Low cliffs,

glacial drift,

alluvial plain

Cobble

beaches,

estuary,

lagoon

Barrier beaches,

sand beaches, salt

marsh, mud flats,

deltas, mangrove,

coral reefs

Coastal Slope % >1,9 1,3 – 1,9 0,9 – 1,3 0,6 - 0,9 <0,6

mm/

year

m/ >+2,0 +1,0 - +2,0 -1,1 - -2,0 <-2,0

year Accretion Accretion Erosion Erosion

Mean tidal range m >6,0 4,1 – 6,0 2,0 – 4,0 1,0 – 1,9 <1,0

Significant wave height m <1,1 1,1 – 2,0 2,0 – 2,25 2,25 – 2,60 >2,60

>1,36

Shoreline erosion/accretion -1,0 - +1,0

Parameters Units

Ranking

Relative sea level rise <-1,21 -1,21 – 0,1 0,1 – 1,24 1,24 – 1,36

II. Objective

The objective of this module is :

 Integrate the value of all parameters into one file format

 Capable to classify the value of each parameters appropriate with the local case.

 Capable to calculate the Coastal Vulnerability Index based of the value class of

each parameters.
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III. Data Processing

Output values for each parameter will be integrated into a cell. After all the values

has integrated into the cell then we will calculate the class of each parameters. At each

parameters in each region we must calculate the percentile value previously, then from

that we can calculate the range value to classify at each parameters. From class value

at parameters in each cell, we will get the value of Coastal Vulnerability Index. We can

calculate the Coastal Vulnerability Index with this formula

Where

a = Class of geomorphology parameter

b = Class of relative sea level rise parameter

c = Class of mean tidal range parameter

d = Class of mean wave height parameter

e = Class of coastal slope parameter

f = Class of shoreline changed parameter

After we get the CVI value, there values will be integrated to spatial into each cell.

Integration this values will use ArcGis software.

Figure 1. Flowchart Integration Variable Data and Integration CVI Data into Cell.
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IV. Data Integration, Classification and Determine Coastal Vulnerability Index
(CVI)

1. For this integration data we will integrate six parameters which influence the coastal

vulnerability index (geomorphology, trend of sea level rise, mean tidal range,

significant wave height, coastal slope, and shoreline changed). There six value of

the parameters during 11 years (1998-2008) arranged like figure below.

2. Value which used to calculate the coastal vulnerability index not original value but

the class value of this parameters. So the original value of this parameters must be

classed previously.

3. Value classify parameters has 4 sample case, The case are west coast, east coast,

national and local, but in here will be discussed only in local cases. To calculate

range in classify process, we will use percentile in Microsoft excel.

4. We must calculate five percentile value to classify the parameters

Example :

=percentile (A1:K51,0)

=percentile (A1:K51,0.25)

=percentile (A1:K51,0.5)

Percentile 5=percentile (block all data,1)

Percentile 4=percentile (block all data,0.75)

Percentile 3=percentile (block all data,0.5)

Percentile 2=percentile (block all data,0.25)

Percentile 1=percentile (block all data,0)
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=percentile (A1:K51,0.75)

=percentile (A1:K51,1)

5. After that we must average percentile 1 and percentile 2 (Y1), percentile 2 and

percentile 3 (Y2), percentile 3 and percentile 4 (Y3), and percentile 4 and percentile

5 (Y4) then from this we get four value, we mention it with Y1, Y2, Y3, and Y4.

6. After we get four percentile value so we will get five class

First class : X < Y1

Second class : Y1 ≤ X < Y2

Third class : Y2 ≤ X < Y3

Fourth class : Y3 ≤ X < Y4

Fifth class : X ≥ Y4

Case upper happen for sea level rise and significant wave height. But for tidal

range, coastal slope and shoreline changed like below

First class : X ≥ Y4

Second class : Y3 ≤ X < Y4

Third class : Y2 ≤ X < Y3
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Fourth class : Y1 ≤ X < Y2

Fifth class : X < Y1

But for parameter geomorphology this case not valid, because parameter

geomorphology have same value range at each region.

First class : X < 1.5

Second class : 1.6 ≤ X < 2.5

Third class : 2.6 ≤ X < 3.5

Fourth class : 3.6 ≤ X < 4.5

Fifth class : X ≥ 4.6

7. After we get range value of this class we will begin classify original value for each

parameters.

Example :

=IF(A1>4.5,"5",IF(A1>3.5,"4",IF(A1>2.5,"3",IF(A1>1.5,"2","1"))))

8. After we get class value for each parameters, we can calculate the coastal

vulnerability index. Formula to calculate the Coastal Vulnerability Index is

where

CVI = Coastal Vulnerability Index

a = Class of geomorphology parameter

b = Class of relative sea level rise parameter [mm/year]

c = Class of mean tidal range parameter [m]

d = Class of mean wave height parameter [m]

=IF(geomorphology value >range fifth

class,"class",IF(geomorphology value > range fourth class," class

",IF(geomorphology value > range third class,"class "
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e = Class of coastal slope parameter [m]

f = Class of shoreline changed parameter [m/year]

9. To calculate CVI with Microsoft Excel we must arranged the same cell in a region

using filter in Microsoft excel

After that we choose the same cell number at this region

After the same cell number arranged, we calculate class value from each

parameters at cell with this formula

Where

a = Class of geomorphology parameter

b = Class of relative sea level rise parameter [mm/year]

c = Class of mean tidal range parameter [m]

d = Class of mean wave height parameter [m]

e = Class of coastal slope parameter [m]

f = Class of shoreline changed parameter [m/year]

The result from this calculate is Coastal Vulnerability Index at a cell in a region
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V. Classification And Calculation CVI Using Macro Excel

1. Beside use the pervious method, to classify parameters value and calculate the CVI

we can use program which made in macro excel.

2. After value of the parameters arranged like in point 1, then this file saved in *.txt

format into folder D:\@-IK-Training\Modul-09-Integrasi\1-

Data_Indikator_Gabungan

3. Then open listing program in folder D:\@-IK-Training\Modul-09-Integrasi\Prog

4. Open that program in macro excel, choose view macros record macro

5. Then will record macro display. At this display we don’t need to change the macro

name.

6. Choose view macros stop recording
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7. To show display to copy the listing program we choose view macros view

macros

8. Then will show the macro display, we choose edit

9. After that Microsoft visual basic display will be showed, the program in main display

can be deleted.

Then copy the listing program to main display
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Then we change the file directory and the range value for each parameters class.

After that we can running the program by push the run icon ( )

10. The result of classify parameters and CVI value will be showed in folder D:\@-IK-

Training\Modul-09-Integrasi\2-Hasil_Integrasi
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VI. LISTING PROGRAM

Sub Main()

Dim DDIR$, T$, S$, HPAR$, PAR$, CLOK$, CIND$, CKAB$, NKAB$, CSEL$, CPAR$, NPAR$, JS$, II$, CCVI$, CV2$

Dim JN, I, J, K, L, M, PJ, DD, JD, JCV, RJCV

Dim LN(6, 5), LM(6, 5), DT$(19), ID(6, 51, 6, 19), SD$(19), CV$(6, 51, 19)

‘DDIRD$ = "D:\My Documents\Modul-14-Integrasi\1-Data_Indikator_Gabungan\"

DDIRS$ = "D:\My Documents\Modul-14-Integrasi\2-Hasil_Integrasi\"

'DATA BATAS NILAI TIAP INDIKATOR

'GEOMORFOLOGI --> 1

LN(1, 1) = 0: LM(1, 1) = 1.5

LN(1, 2) = 1.5: LM(1, 2) = 2.5

LN(1, 3) = 2.5: LM(1, 3) = 3.5

LN(1, 4) = 3.5: LM(1, 4) = 4.5

LN(1, 5) = 4.5: LM(1, 5) = 5.5

‘

'KENAIKAN MUKA LAUT RELATIF --> 2

LN(2, 1) = 0: LM(2, 1) = 4.077179

LN(2, 2) = 4.077180: LM(2, 2) = 4.162275

LN(2, 3) = 4.162276: LM(2, 3) = 4.252121

LN(2, 4) = 4.252122: LM(2, 4) = 4.305794

LN(2, 5) = 4.305795: LM(2, 5) = 9999

'RATA-RATA KISARAN PASUT --> 3

LN(3, 1) = 0.960942: LM(3, 1) = 9999

LN(3, 2) = 0.928148: LM(3, 2) = 0.960941

LN(3, 3) = 0.885715: LM(3, 3) = 0.928147

LN(3, 4) = 0.800665: LM(3, 4) = 0.885714

LN(3, 5) = 0: LM(3, 5) = 0.800664

'RATA-RATA TINGGI GELOMBANG --> 4

LN(4, 1) = 0: LM(4, 1) = 0.448335

LN(4, 2) = 0.448336: LM(4, 2) = 0.493923

LN(4, 3) = 0.493924: LM(4, 3) = 0.521222

LN(4, 4) = 0.521223: LM(4, 4) = 0.569881

LN(4, 5) = 0.569882: LM(4, 5) = 9999

‘

'KEMIRINGAN --> 5

LN(5, 1) = 1.4716: LM(5, 1) = 9999

LN(5, 2) = 1.1485: LM(5, 2) = 1.4715

LN(5, 3) = 0.8501: LM(5, 3) = 1.1484

LN(5, 4) = 0.4286: LM(5, 4) = 0.8500

LN(5, 5) = 0: LM(5, 5) = 0.4285

‘

'PERUBAHAN GARIS PANTAI --> 6

LN(6, 1) = 4.449935: LM(6, 1) = 9999

LN(6, 2) = 0.583983: LM(6, 2) = 4.449934
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LN(6, 3) = -0.02136: LM(6, 3) = 0.583982

LN(6, 4) = -0.935521: LM(6, 4) = -0.02137

LN(6, 5) = -9999: LM(6, 5) = -0.935522

JN = 19

JN = JN - 1

T$ = ","

S$ = Chr(9)

Open DDIRD$ + "Data_Indikator.txt" For Input As #1

Line Input #1, HPAR$

Open DDIRS$ + "Data_Klf.txt" For Output As #2

Print #2, HPAR$

While Not EOF(1)

Line Input #1, PAR$

For I = 1 To JN

PJ = Len(PAR$)

L = InStr(1, PAR$, T$)

DT$(I) = Mid$(PAR$, 1, L - 1)

PAR$ = Mid$(PAR$, L + 1, PJ - L)

If I = JN Then DT$(I + 1) = PAR$

Next I

CLOK$ = Trim(DT$(1))

CIND$ = Trim(DT$(2))

CKAB$ = Trim(DT$(3))

NKAB$ = Trim(DT$(4))

CSEL$ = Trim(DT$(5))

CPAR$ = Trim(DT$(6))

NPAR$ = Trim(DT$(7))

If CKAB$ = "3603" Then I = 1

If CKAB$ = "3175" Then I = 2

If CKAB$ = "3216" Then I = 3

If CKAB$ = "3326" Then I = 4

If CKAB$ = "3375" Then I = 5

If CKAB$ = "3578" Then I = 6

J = Val(CSEL$)

K = Val(CPAR$)

For L = 8 To 19

For M = 1 To 5

DD = Val(DT$(L))

If DD > LN(K, M) And DD <= LM(K, M) Then

ID(I, J, K, L) = M

SD$(L) = Trim(Str(M))

End If

Next M

Next L
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Print #2, CLOK$ + S$ + CIND$ + S$ + CKAB$ + S$ + NKAB$ + S$ + CSEL$ + S$ + CPAR$ + S$ + NPAR$ + _

S$ + SD$(8) + S$ + SD$(9) + S$ + SD$(10) + S$ + SD$(11) + S$ + SD$(12) + S$ + SD$(13) + _

S$ + SD$(14) + S$ + SD$(15) + S$ + SD$(16) + S$ + SD$(17) + S$ + SD$(18) + S$ + SD$(19)

Wend

Close #2

Close #1

Open DDIRS$ + "Data_CVI.txt" For Output As #2

Print #2, "LOKASI" + S$ + "KODE_CVI" + S$ + "KODE_KAB" + S$ + "NAMA_KAB" + S$ + "KODE_SEL" + S$ +

"CVI_1998" + S$ + "CVI_1999" + S$ + "CVI_2000" + S$ + _

"CVI_2001" + S$ + "CVI_2002" + S$ + "CVI_2003" + S$ + "CVI_2004" + S$ + "CVI_2005" + S$ + "CVI_2006" + S$

+ "CVI_2007" + S$ + "CVI_2008" + S$ + "RATA_CVI_1" + S$ + "RATA_CVI_2"

For I = 1 To 1

If I = 1 Then JD = 51: II$ = "1": CKAB$ = "3603": NKAB$ = "TANGERANG"

If I = 2 Then JD = 37: II$ = "2": CKAB$ = "3175": NKAB$ = "KOTA JAKARTA UTARA"

If I = 3 Then JD = 46: II$ = "3": CKAB$ = "3216": NKAB$ = "BEKASI"

If I = 4 Then JD = 11: II$ = "4": CKAB$ = "3326": NKAB$ = "PEKALONGAN"

If I = 5 Then JD = 10: II$ = "4": CKAB$ = "3375": NKAB$ = "KOTA PEKALONGAN"

If I = 6 Then JD = 45: II$ = "5": CKAB$ = "3578": NKAB$ = "KOTA SURABAYA"

For J = 1 To JD

If J < 10 Then JS$ = "00" + Trim(Str(J))

If J >= 10 And J < 100 Then JS$ = "0" + Trim(Str(J))

If J >= 100 And J < 1000 Then JS$ = Trim(Str(J))

CCVI$ = CKAB$ + "_" + JS$

For L = 8 To 19

CV$(I, J, L) = Trim(Str(Sqr((ID(I, J, 1, L) * ID(I, J, 2, L) * ID(I, J, 3, L) * ID(I, J, 4, L) * ID(I, J, 5, L) * ID(I, J, 6, L)) / 6)))

Next L

JCV = Val(CV$(I, J, 8)) + Val(CV$(I, J, 9)) + Val(CV$(I, J, 10)) + Val(CV$(I, J, 11)) + Val(CV$(I, J, 12)) + Val(CV$(I, J,

13)) + Val(CV$(I, J, 14)) + _

Val(CV$(I, J, 15)) + Val(CV$(I, J, 16)) + Val(CV$(I, J, 17)) + Val(CV$(I, J, 18))

If JCV <> 0 Then

RJCV = JCV / 11

Else

RJCV = 0

End If

CV2$ = Trim(Str(RJCV))

Print #2, II$ + S$ + CCVI$ + S$ + CKAB$ + S$ + NKAB$ + S$ + JS$ + S$ + CV$(I, J, 8) + S$ + CV$(I, J, 9) + S$ +

CV$(I, J, 10) + S$ + CV$(I, J, 11) + S$ + CV$(I, J, 12) + S$ + _

CV$(I, J, 13) + S$ + CV$(I, J, 14) + S + CV$(I, J, 15) + S + CV$(I, J, 16) + S + CV$(I, J, 17) + S + CV$(I, J, 18) +

S + CV$(I, J, 19) + S + CV2$

Next J

Next I

Close #2

End Sub
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VII. Data Integration to GIS

1. Open D:\@-IK-Training\Modul-09-Integrasi\2-Hasil_Integrasi\Data_Klf.txt make

sure this file have value of six parameters at one region

Make sure the number of parameters arranged in series (geomorphology, relative

sea level rise, mean tidal range, mean wave height, coastal slope, and shoreline

changed) then open file D:\@-IK-Training\Modul-09-Integrasi\3-GIS_Lokasi\1-

Tangerang\ID_Indikator.txt

Copy class value each parameter at file Data_Klf into this file.

2. Open ArcMap ( ) at ArcGis, then display like below will be showed
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Choose A new empty map.

3. Then we choose to input file that we will integration to GIS, then after we add

file D:\@-IK-Training\Modul-09-Integrasi\3-GIS_Lokasi\1-

Tangerang\ID_Indikator.txt, double click on that file to showing the data of that file.

choose Display XY Data

After that at Display XY data fill X Field as longitude and Y Field as Latitude. After

that we choose edit, after the display like below showed we choose Select

Geographic coordinate system world WGS 1984.prj
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4. Then export that file into spatial. Right click at that file then choose data export

data. Choose data frame, then choose sign to choose folder to save the data.

5. Then add file D:\@-IK-Training\Modul-09-Integrasi\3-GIS_Lokasi\1-

Tangerang\data_indikator_n

Overlay with previously result until produce figure like this
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6. Before that we search delete field at toolbox ArcGis to delete doesn’t needed field.

Then figure like below will be showed

Beside that seven fields except 7 field, we can delete another fields.

7. Then we choose spatial join at ArcGis toolbox column to integrate data.



181

Fill the target feature with data_indikator_n, while fill the first result at join feature.

Then we choose OK.

8. After that will show new display that mark the two file have been integrated. To

show the graduated color display can be showed like previously instruction at GIS

introduction.

9. The same method can be used to integrate CVI to GIS. For CVI we use file at D:\@-

IK-Training\Modul-09-Integrasi\2 Hasil_Integrasi\Data_CVI.txt and D:\@-IK-

Training\Modul-09-Integrasi\3-GIS_Lokasi\1-Tangerang\ID_CVI_Darat.dbf. Copy
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column BUJUR, LINTANG, LOKASI, KODE_CVI, KODE_KAB, NAMA_KAB, and

KODE_SEL from second file and CVI_1998, etc from first file. Integrated to one file

and save to *.txt format (ASCII).

10. Then the same method like number 2 and etc can be applied. That file will showed,

then change the projection use WGS 1984. Then export the data to *.shp format.

Then we display D:\@-IK-Training\Modul-09-Integrasi\3-GIS_Lokasi\1-

Tangerang\Data_CVI_Darat.shp, previously we need to delete the field that not

used.
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Then we need to make spatial join to integrate two file.
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11. Combination between Data_CVI with Data_Indikator can we visualization at same

time to see the influential parameters to coastal vulnerability.
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1. What is an altimeter and radar altimetry?

Altimeter - An instrument that determines height above a reference level, commonly by
measuring the change of atmospheric pressure, or by measuring vertical distance
directly with a radar or laser system.

Radar Altimetry - The measuring of range from an aircraft or satellite to the sea surface
using a short pulse of microwave radiation with known power toward the sea surface.
The pulse interacts with the rough sea surface and part of the incident radiation reflects
back to the altimeter. The techniques for determining the range to the ocean surface
based on the travel time of such a microwave pulse is commonly referred to as altimetry.

Since 1996, global, near-real-time maps of mesoscale anomalies derived from tandem
sampling provided by altimeters aboard the TOPEX/Poseidon and ERS-2 satellites have
been posted on web pages hosted at the Colorado Center for Astrodynamics Research.
The original, near-real-time processing system was based on a quick-look analysis that
referenced the data to a high-resolution gridded mean sea surface available at the time.
Recently, state-of-the-art mean sea surfaces have been derived that are based on a
more complete record of altimeter observations. An updated mesoscale monitoring
system based on a new mean surface is described and shown to provide improved
mesoscale monitoring to the successful system implemented in 1996 (Leben et al.,
2000).

The measurement of sea surface height from space by a satellite borne altimeter is
deceptively simple:

1. Send a microwave pulse to the ocean surface and detect the reflected pulse,
measuring the two-way travel time between sending and receiving the pulse.

2. Calculate the distance of the ocean surface from the satellite, the altimeter range,
by multiplying the one-way travel by the speed of light. The one-way travel time is
equal to 1/2 the two-way travel time.

3. Adjust range measurement to account for atmospheric, pulse reflection,
instrument and external geophysical corrections to the path length.

4. Determine the ocean height by subtracting the range from the orbit height of the
satellite.

While measuring sea surface elevation from space is conceptually simple, satellite
altimetry is in fact quite complex, requiring nearly 60 algorithms and a variety of external
measurements to accurately determine the sea surface height elevation associated with
dynamic ocean currents.
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Figure 1. Schematic Summary Corrections

Figure 2. Sample Altimeter Data Product, Contoured altimeter data overlaid on SST
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2. Altimeter History

The first space borne microwave altimeter few on Skylab in 1973. This was a proof of
concept study to test instruments for the Seasat mission to be flown later in the decade.
A scatterometer and radiometer were also flown and tested aboard Skylab.
 The altimeter, scatterometer and radiometer shared the same antennae.
 The antennae was gimbaled to look at backscatter and irradiance as a function of

incident angle.
 The ground coverage at nadir was 11.1 km in diameter.

NASA’s Geodynamics Experimental Ocean Satellite (GEOS-3) carried the first
instrument to yield useful measurements of sea level and its variability with time.
 Primary Mission - Geodesy
 Launched in April 8, 1975
 Near circular orbit, inclination 115°, 843 km altitude of 843, non repeating ground

tracks where successive tracks cross the equator every 101.8 minutes with a
precession of about 26°. Mapped the ocean a 1° by 1° resolution in
approximately one month.

 The altimeter operated at 13.9 GHz with a pulse repetition frequency of 100 Hz.
 Precision is estimated to be 50 cm rms.
 Operational from 1975 through approximately 1981

Seasat was the first satellite dedicated to the study of the global oceans with microwave
sensors. It carried five sensors: a radar altimeter, a scatterometer system, a synthetic
aperture radar, a visible and infrared radiometer and a scanning multi-channel
microwave radiometer. Despite its short lifespan, this mission and the data collected
served a crucial role in advancing satellite altimetry to a preeminent role in global ocean
circulation monitoring.
 Launched on June 26, 1978 and failed due to a “massive short circuit in the

satellite electrical system” on October 10, 1978.
 Near circular orbit, inclination 108°, period 101 min., and altitude 790 km.
 Orbit pattern - 3-day and 17-day near repeat. Ground track later overflown

during GEOSAT Exact Repeat Mission so that data could be released
unclassified.

The U.S. Navy GEOdetic SATellite carried an altimeter that was capable of measuring
the distance from the satellite to the ocean surface with a relative precision of about 5
cm.
 Primary mission phase, the Geodetic Mission, was dedicated to mapping the

marine geoid at high spatial resolution. Data were originally classified. The data
around Antarctica were declassified in 1990 and the entire data set in June, 1995.

 Launched on March 12, 1985.
 Near circular orbit, inclination 108°, period 101 min, and altitude 800 km.
 The Exact repeat mission phase began on November 8, 1986 after the satellite

was maneuvered into a 17-day repeat orbit ( actually 17.05 days ) until the
satellite ultimately failed in January 1990.

 Public release of the high resolution Geodetic data allowed the estimation of sea
floor topography using satellite altimetry.

Respectively launched by the European Space Agency (ESA) in 1991 and 1995, the
ERS-1 and ERS-2 satellites for Earth Observation both carried satellite altimeters in
addition to a wide variety of other instruments.
 ERS-1 had multiple mission phases including: Commissioning (3-day repeat), Ice

1 (3-day repeat), Multidisciplinary 1 (35-day repeat), Ice 2 (3-day repeat),
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Geodetic 1 & 2 (168-day repeat with 8 km offset between 1&2), and
Multidisciplinary 2 (35-day repeat). ERS-1 failed on March 10, 2000.

 A tandem mission phase of ERS-1 & 2 was flown in 1995.
 ERS-2 was launched on April 21, 1995 and was immediately placed in the 35-day

repeat orbit used for the multidiciplary phases of the ERS missions.
 ENVISAT, the third satellite in the series, was launched on March 1, 2002 and

placed in the same orbit.

The U.S. Navy’s GEOSAT Follow-on Mission (GFO) is the follow-on mission to the highly
successful GEOSAT mission. This mission is dedicated to providing operational
oceanographic products to maintain continuous ocean monitoring from the GEOSAT
ERM orbit.
 Launched on February 10, 1998.
 Placed in 17-day repeat orbit flown during GEOSAT ERM mission phase.
 Hardware problems delayed data release until March 2001.
 Decommissioned in December 2008.

A joint NASA/CNES satellite altimeter mission launched on August 10, 1992.
 Carried two altimeters: the dual frequency TOPEX altimeter and the solid-state

Poseidon altimeter, which shared a single antennae on the satellite.
 Highly successful primary and extended missions collected 364 10-day repeat

cycles of data through 8/11/2002.
 TOPEX and Jason-1 flew in the same orbit (with Jason leading by 60 seconds)

for the first 21 repeat cycles of the Jason mission to intercalibrate the satellites.
 Starting on August 15, 2002 T/P was maneuvered into an interleaved orbit for

tandem sampling mission with Jason-1. The interleaved mission phase started
on September 20, 2002.

 Decommissioned in January 2006.

Operational Missions: Near real-time and archival data are available from the following
ongoing missions:

• Jason-1
• Envisat
• OSTM/Jason-2

All of these data are currently being processed and archived at CU/CCAR.
http://argo.colorado.edu/~realtime/welcome/

Jason-1: A joint U.S./French NASA/CNES satellite altimeter mission.
Jason-1 is a T/P “follow-on” and was placed in the T/P 10-day repeat orbit.
 Launched on December 7, 2001.
 Initial 6-month calibration phase, in which Jason-1 was on orbit 60 seconds

behind T/P, was followed by a maneuver of T/P into a “tandem” interleaved 10-
day repeat orbit to increase mesoscale sampling. T/P was placed into
“interleaved” orbit on September 20, 2002.

 After calibration of Jason-2/OSTM, Jason-1 was placed into in the “interleaved”
orbit where it is flying today.

Envisat: This is the European Space Agency (ESA) Environmental Satellite (Envsat) a
follow-on to the ERS-1&2 altimeter missions.
 Launched March 1, 2002.
 Envisat replaced the ERS-2 satellite. Tandem mission plans are not clear, but

CU/CCAR has existing processing capabilities to use data as soon as available,
as was done during the ERS-1&2 tandem missions in 1995-1996.
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 Calibration and validation was completed and the satellite became operational in
January 2003.

 Dr. Leben is a USA Envisat P.I. working on the project titled “Monitoring the Intra-
Americas Sea Through-flow with Satellite Altimetry”. USA P.I.s are not funded by
ESA, but are given full access to the data stream and may disseminate derived
products.

Ocean Surface Topography Mission (OSTM)/Jason-2: A joint U.S./French NASA/CNES
satellite altimeter mission.

 OSTM/Jason-2 is a T/P “follow-on” mission and was placed in the T/P 10-day
repeat orbit.

 Launched on June 20, 2008.
 Initial 6-month calibration phase, in which Jason-2 was in orbit 58 seconds behind

Jason-1, was followed by a maneuver of Jason-1 into the “tandem” interleaved
10-day repeat orbit to increase mesoscale sampling on 14 Feb 2009.

Tabel 1. Ocean Altimeter Mission Summary
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3. Altimeters Range Corrections

Altimeter range corrections can be grouped as follows:
 Atmospheric Refraction Corrections
 Sea-State Bias Corrections
 External Geophysical Corrections
 Instrument Corrections

The presence of dry gases, water vapor and free electrons in the atmosphere reduces
the propagation speed of the radar pulse. These are the so-called atmospheric range
corrections.
 Dry Gases
 Water Vapor
 Ionospheric Free Electrons

Atmospheric Range Corrections: Dry Gases

All of these corrections cause a delay in the returned signal and are often referred to as
a path delay, acting to make the range measurement too long.
At microwave frequencies the troposphere is a non-dispersive medium, and the index of
refraction is independent of frequency. For convenience the path delay is broken into a
dry and wet component. The dry component reflects primarily the refractive effects of
oxygen on the path delay.
A simplified expression for the dry troposphere range correction, which takes into
account the variation in gravity with latitude, is given by the formula:
∆R_dry ≈ 0.2277*P(1 + 0.0026cos(2 latitude))
Where P is the sea level pressure in millibars and ∆R_dry is in cm.
This range correction averages 226 cm with variations of 2 cm. The uncertainty
associated with errors in the pressure fields from numerical weather models is about 1
cm.

Atmospheric Range Corrections: Water Vapor
The atmospheric range correction associated with columnar water vapor is called the wet
troposphere correction and reflects water vapor and cloud liquid water droplet
contributions to atmospheric refraction.
This effect is parameterized by empirical formula: ∆R_wet ≈ 1.6 L
where L is the integrated columnar liquid water in gm/cm^2 and ∆R_wet has units of cm. 
This range correction averages 10 cm at high latitudes to 24 cm in tropical regions. Time
variations are about 5 cm. The uncertainties is about 1 cm when corrected using a
three-frequency microwave radiomenter.

Figure 2. TMR Water Vapor (g/cm2)
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Microwave Radiometry

Modern altimeter rely on bore-sight radiometers to estimate the ∆R_wet.
 Algorithms using three frequency ( 18, 21 and 37 GHz) brightness temperature

trained on a large global database of radiosonde profiles to estimate ∆R_wet 
have accuracies of about 1 cm in rain free conditions

 Algorithms based on the two frequencies (23.8 and 36.5 GHz) used in the ERS
radiometers have accuracies of about 2 cm rms.

Atmospheric Range Corrections: Ionospheric Free Electrons

Electrons liberated from atoms in the ionosphere by energetic solar radiation interact
with microwaves to slow their propagation. Since the ionosphere is a dispersive
medium, the refraction is a function of the frequency so that the free electron density can
be calculated using the ranges measuremetns at different frequencies.
The ionosphere range correction is calculated from the total electron content unit (TECU)
using the formula: ∆R_iono = 0.22 TECU, where TECU is given in 10^16 electrons per 
meter^2 with ∆R_iono in cm.

Like the wet troposphere correction, accurate measurements of TECU are required for
accurate altimetry given the time and space scales of ionospheric variability
Note: The ability to correct satellite altimeter data for water vapor attenuation requires
coincident measurements from a passive microwave radiometer onboard the satellite
because the columnar water vapor at any particular location varies with time.
This was an important lesson learned from GEOSAT.

Scales of the Ionospheric Delay
The ionosphere exhibits spatial and temporal variations that are difficult to reproduce
with numerical models. Observations show:
 Mean values of the ionospheric delay range from 12 cm near the equator to 6 cm

at higher latitudes.
 Variations about the mean are as large as 5 cm near the equator and 2 cm at

higher latitudes.
 Meridional gradients as large as 2 cm per 100 km can occur during mid to late

afternoon at latitudes of 20° to 30°.
 Uncertainty in the measurements are about 1 cm after smoothing the ionospheric

correction at length scales less than 100 km.

Sea State Bias Corrections
The sea state bias is made up of two components
 Electromagnetic (EM) Bias - the difference between mean sea level and the

mean scattering surface.
 Skewness Bias - the difference between the mean scattering surface and the

median scattering surface.
Recall that the returned signal measured by an altimeter is the pulse reflected from the
small wave facets within the antenna footprint that are oriented perpendicular to the
incident wave fronts.
The shape of the returned waveform is thus determined from the distribution of these
scatterers rather than the distribution of the actual sea surface height.
The half power point on the leading edge of the returned wave form corresponds to the
median scattering surface.



195

External Geophysical Corrections
 Geoid height - An accurate geoid is needed to calculate the total dynamic

topography signal that includes both the mean ocean circulation and its
variations. Early geoids have not been accurate enough for this application,
however, by including gravity measurements form GRACE mission have reduced
geoid errors at scales greater than 300 km so that scientifically useful information
can be derived.

 Ocean and solid earth tidal height - Both ocean and solid earth tides are
measured by the altimeter and are considered noise on the non-tidal dynamical
signal. Existing models derived from T/P data are accurate to better than 2 cm
rms in the deep ocean.

External Geophysical Corrections (cont.)
 Atmospheric pressure loading - This is simply the depression of the sea surface

by the atmosphere pressure force on the ocean surface. Spatial and temporal
variations of this force are compensated partially by variations in the surface
elevation. To first order, the ocean response as an “inverse barometer”,
changing height by about one centimeter per milli bar of pressure change.

∆ IB (cm) ≈ 0.995 (P-1013)
where P is the sea level pressure and 1013 is the mean sea level pressure.
In reality, the ocean responds both statically and dynamically depending on the
spatial and temporal scales of the forcing.

 Barotropic ocean signals, which are have significant power at periods shorter
than 20 days and are aliased by altimetric sampling, also an important external
geophysical correction being studied. Barotropic ocean models forced with wind
and pressure, however, are not sufficiently accurate reliable corrections for
barotropic variability in routine altimeter data processing.

Instrument Corrections (some)
 Doppler shift - Doppler shifting of the transmitted chirp affects the range

calculation. This is corrected using the range rate, the rate of change of the
range. Range rate is calculated in ground processing by least squares fitting of
the range data over about 3 seconds of TOPEX data.

 Range acceleration - The tracker algorithm is affected by the range acceleration.
The range acceleration is calculated using the least squares employed for the
range rate. Range rates can be as high as 10 meters per second^2 over ocean
trenches.

 Oscillator drift - any drift in the frequency of the oscillator direct affects the range
calculated by counting cycles of the on board oscillator. This is calibrated by
timing of telemetry signals at a ground receiving station. The distinction between
frequency and counts per second resulted in an error in the ground based
software for TOPEX causing a significant drift and bias in the altimeter
measurement.

 Pointing angle/sea state - the largest source of instrumental error is caused by of
nadir pointing of the altimeter instrument. To varying degrees this affects the
adaptive tracker unit (ATU) estimates of two-way travel time, the significant wave
height and the sigma naught.

Original CCAR Near Real-time Altimeter System
 Quick-look processing designed to retain and map mesoscale variability.
 Went online in early 1996.
 Used NOAA Laboratory for Satellite Altimetry ERS and Geosat Follow-on near

real-time altimeter data products.
 Enhanced NOAA corrections.
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 Delft Institute for Earth-Oriented Space Research orbits.
 Used near real-time TOPEX RGDRs

 Processed by the Naval Oceanographic Office Altimeter Data Fusion
Center.

 JPL Earth Orbiter Systems Group GPS orbit.
 CCAR system was designed so that quick-look products are processed and

posted by 12:00 p.m. MST.

Original CCAR Quick-look mesoscale analysis
 All altimeter data were referenced to an independent gridded mean sea surface.

 The data were treated as non-repeating ground tracks and were
referenced directly to the mean sea surface (non-collinear processing).

 Saved a significant amount of computational effort during near real-time
processing.

 Along track loess filtering was used to remove residual orbit and environmental
correction errors.
 The loess filtering removed a running least squares fit of a tilt and bias

(line) within a sliding window from the along-track data.
 The window width was approximately 15 degrees (or 200 seconds) along

track.
 The detrended data were objectively mapped to a 1/4° grid.
 In the Gulf, a model mean or mean dynamic height was added to the anomaly to

estimate the total sea surface height.

Current CCAR Near Real-time Altimeter System
 Updated “collinear” processing and new reference mean sea surface.
 Went online in summer 2003.
 Uses NOAA Laboratory for Satellite Altimetry Geosat Follow-on (GFO) near real-

time altimeter data products.
 Uses near real-time Jason-1 and OSTM Jason-2 RGDRs
 JPL Earth Orbiter Systems Group GPS orbits and real-time data.
 ESA Envisat data were added in the summer of 2004.
 Entire system was moved to an Apple Mac G5 in the summer of 2005.
 Products posted at 8 am MST or MDT Time (GMT-7 or -6)


Online Data Access Tools
Gulf of Mexico Interactive Online Data Forms

 Gulf of Mexico Near Real-Time Data Viewer
 Gulf of Mexico Near Real-Time Geostrophic Velocity Viewer
 Gulf of Mexico SST/SSH Overlay
 Gulf of Mexico Ocean Color/SSH Overlay
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Figure 3. Example Real time Mesoscale Altimetry

4. Sea Level Reconstruction Using Tide Gauges and Satellite Altimetry

Estimating Rate of Sea Level Rise
• Rates of sea level rise over the past several decades using either fully empirical

or semi-empirical techniques have been published recently.
• Church et al. (2004), Jevrejeva et al. (2006),Church et al.

(2006),Rahmstorf et al. (2007),Grinsted et al. (2009),Merrifield et al.
(2009)

• Each technique uses satellite altimetry data, tide gauge data or some
combination of the two.

• Over the period from 1950 to 2010, estimates of global mean sea level (GMSL)
range from around 1.5 mm/yr to 2.1 mm/yr.

• Such studies often form the basis for projecting GMSL into the future.

Reconstructing Sea Level with CSEOFs
A procedure for reconstructing sea level has been implemented using CSEOFs in place
of the more conventional EOFs.

1. Compute CSEOF loading vectors (LVs) from 16-year satellite altimeter record,
1993-2008, and truncate to 10 LVs to avoid overfitting of the tide gauge data.
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2. High-pass filter tide gauge data using a 3-year window to retain signals well
represented by the CSEOF LVs and to remove tide gauge datum artifacts.

3. Calculate a weighted least-squares fit of the LVs to compute the reconstructed
PCs and time series.

Figure 4. AVISO Sea Level Trends 1993-2008

Figure 5. Reconstructed Sea Level Trends: 1950-2009
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Figure
6. observation of Global Mean Sea Level Variation

• The CSEOF reconstructed trend and trend computed from the AVISO altimeter
record show good agreement over the period from 1993 to 2010.

• The GMSL trend computed from the CSEOF reconstruction over the
period from 1950 to 2010 is 2.5 mm/yr, higher than previous estimates
over the same period.

• Caution must be used when interpreting GMSL trends computed from sea level
reconstructions.

• The GMSL obtained from reconstructions depends heavily on the tide
gauge editing and on the selected method of weighting for the
reconstruction procedure.

• Ideally, regional clustering of tide gauges should be avoided by using
equal area weighting (Merrifield et al. 2009).

• The effects of tide gauge editing and weighting on the results of
reconstructions still needs to be better understood.

Empirical Orthogonal Functions (EOFs)

 The large amounts of data that are usually studied in climate exhibit a complex
mixture of signal and noise. The purpose of statistical analysis is to disentangle
this mixture to find the needle (the signal) in the haystack (the noise).

 The allegory with the needle in the haystack has two sides. First, it is difficult to
find the needle in the haystack. Second, after it has been found, it should be
easily recognizable as a needle simply by looking at it.

 To identify a climatic signal, advanced techniques may be required, but after its
identification, the signal usually may be described by means of simple techniques
such as composites, correlations, etc.”

- Von Storch & Frankinoul (1998)



200

 A fundamental characteristic of ocean data is the high dimension of the variables
representing the state of the system at any given time. Often it is advantageous
to perform a subspace decomposition to split the full phase space into two
subspaces, i.e. the signal subspace and the noise subspace.

 One such statistical method is Empirical Orthogonal Functions.
 The roots of this method arose in the early 1900’s as objective tests of

intelligence were being developed. Although, later on several other fields
independently developed the statistical techniques.

Computing EOFs with SVD

Basic Algorithm
1. Put the data into a matrix, F, so that each row is a time series of the data at a

point and the columns are variables or spatial data at specific times.
2. Remove the mean from each row so that there is no time mean signal in the data

set.
3. Use SVD to decompose the data into three matrices:

F = U*S*VT
where:
U = the left eigenvectors
VT = the right eigenvectors
S = singular values
In this example:
U = the EOFs (spatial patterns)
S*VT = the EOF time series or Principal Components (PCs).

There is no consistent terminology for EOF and PC analyses. Here are some terms
commonly used.
 EOFs may be called the loading vectors.principal component loading patterns,

principal vectors, or principal loadings.
 The EOF time series may be called eigenvector time series, expansion coefficient

time series, expansion coefficients, time coefficients, time components, principal
component time series, principal component scores, principal component
amplitudes, principal components, or scores.

We will call the EOFs the loading vectors (LVs) and the EOF time series the principal
components (PCs).
Note that switching the association of time and space indices in the data matrix, F, does
not make a difference in the SVD decomposition. The EOFs are now associated with
VT, and the PCs with U*S.

The eigenvalues of the expansion are equal to the square of the singular values. To
compute the percent of variance explained by a given EOF use the following formula:

% variance of component i = Si2 / trace(SST)
or
% variance of all components = diag(S*ST)/ trace(SST)

SST is sometimes referred to as the communalities matrix.
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Figure 6. Global SSH EOFs and PCs - Modes 1 & 2

Non-Stationary Periodic Signals

 The spatial patterns of many geophysical processes change in time at longer
time-scales than their well-defined periods. For example, most annual cycles are
not stationary and change amplitude over time.

 In many studies, the signal associated with the annual cycle is removed prior to
analyzing the data.
 The annual cycle is often not of scientific interest and certain types of

analysis can be hindered by the presence of this signal.
 Techniques commonly applied for removing the annual cycle do not

handle the time-dependent spatial patterns well.
 Simply removing the time-invariant annual cycle is often not sufficient.

Cyclostationary EOFs

 To account for time-varying spatial patterns, Kim et al. (1996) introduced
Cyclostationary EOFs (CSEOFs).

 In traditional EOF analysis, space-time data are represented in terms of loading
vectors (LVs) and principal components (PCs).
 LVs represent patterns or spatial variability in the dataset.
 PCs represent the temporal variability of the LVs.

 The significant difference between CSEOF and EOF analysis is the time-
dependence of the LVs.
 The temporal evolution of the LVs is constrained to be periodic with a

certain “nested period”.
 For the analysis of the annual cycle, this nested period is equal to one

year.

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Computing CSEOFs

 The method for computing CSEOFs is based on the theory of harmonizable
functions.

 CSEOFs are defined as products of Bloch functions and Fourier functions.
 Several papers by K.-Y. Kim establish the theoretical basis of CSEOFs in addition

to providing methods for efficiently computing CSEOFs.
 Kim et al. (1996);
 Kim and North (1997);
 Kim and Wu (1999);
 Kim and Chung (2001).

CSEOFs are computed from the multi-mission AVISO altimeter dataset spanning the 16-
year record from 1993-2008.
 CSEOF #1 accounts for 35% of the variability in the dataset and reflects the

annual SSH variability.
 CSEOF #2 accounts for 17% of the variability in the dataset, which is associated

with the El Nino/Southern Oscillation (ENSO) signal.
 In total, just 17 CSEOFs account for 99% of the SSHA variability in the AVISO

dataset.

Figure 7. CSEOFs
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Figure 8. Indonesia Region Sea Level Trends

Future Studies

 Future studies are planned to use Seasat and Geosat altimeter data to assess
the quantitative accuracy of the reconstructed times series.

 We also plan to exploit the reconstructed fields to improve filtering of residual
Seasat and Geosat orbit and pathlength errors.

 A validated dataset will allow us to study in detail the long-term climate signals
described by the sea level record.

 Please use our reconstructed dataset in your research. We have given you a
preliminary version of the dataset. Check with us for updates and for literature
citation if you intend to publish a paper. leben@colorado.edu
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5. Laboratory Work for processing altimeter data using Matlab Software

Example Using Datenum to Create AVISO Filenames

% Example using datenum to create AVISO filenames
clear
clc
% Aviso dataset:
% start date 14-Oct-1992
% end date 22-Feb-2006 use datenum(year,month,day)
num1 = datenum(1992,10,14)
num2 = datenum(2006,2,22)
% check
[ datestr(num1) ' to ' datestr(num2) ]
% create Aviso date text string e.g. 19921014
n = num1
dateval = datestr(n,30);
dateval = dateval(1:8);
dateval = [ dateval(1:8) '_' dateval(1:8)]
% now make Aviso filename
% dataset info
dataset_name = 'dt_ref_global_merged_msla_h_qd_';
dataset_date_stamp = '_20080107.mat';
% filename
filename = [ dataset_name dateval dataset_date_stamp ]

for n=num1:7:num2
dateval = datestr(n,30);
dateval = dateval(1:8);
dateval = [ dateval(1:8) '_' dateval(1:8)];
% filename
filename = [ dataset_name dateval dataset_date_stamp ]

end

% loop to load data and calculate mean
datadir = [ '/Users/leben/presentation/data/avisomerged/globalMat/'];
for n=num1:7:num1

dateval = datestr(n,30);
dateval = dateval(1:8);
dateval = [ dateval(1:8) '_' dateval(1:8)];
% filename
filename = [ dataset_name dateval dataset_date_stamp ]
load([ datadir filename]);
mean_ssh = mean(mean(ssh(find(ssh<8.7e+18))))

end
% now loop over all files and save mean
npts = size([num1:7:num2],2)
mean_ssh = NaN*ones(npts,1);
dnum = NaN*ones(npts,1);
np=0;
for n=num1:7:num2
% for n=num1:7:num1

np = np + 1;
dateval = datestr(n,30);
dateval = dateval(1:8);
dateval = [ dateval(1:8) '_' dateval(1:8)];
% filename
filename = [ dataset_name dateval dataset_date_stamp ]



206

load([ datadir filename]);
% calculate mean
mean_ssh(np) = mean(mean(ssh(find(ssh<8.7e18))));
% save datenum
dnum(np) = datenum(n);

end
mean_ssh(1)
%
figure(1)
subplot(3,1,1)
plot(mean_ssh)
subplot(3,1,2)
plot(dnum,mean_ssh)
subplot(3,1,3)
plot(dnum,mean_ssh)
datetick
save aviso_mssh mean_ssh dnum
%
% %mean_ssh = mean(mean(ssh(find(ssh<8.7e18))))
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Sample Matlab Code to Compute Dates of along Track Data Points

% Sample Matlab code to compute dates of along track data points
% from OSTM real time collinear data sets
%
clear
% Note that cycle times are given in seconds past 1/1/2000 00:00 GMT
toolsdir = ['/Users/leben/presentation/tools/'];
filename = [ toolsdir 'cycleTimesOSTM.txt'];
load(filename)

% there are 856711 once-per-second points in a 10-day repeat
point = 1;
ncycles = size(cycleTimesOSTM,1);
for ncyc=1:ncycles
% calculate how many data past y2000 the time is

ndays = (cycleTimesOSTM(ncyc,2)+point-1)/24/3600;
cycle = cycleTimesOSTM(ncyc,1);
[ 'Cycle #',int2str(cycle), ' Point #' int2str(point) ' '

datestr(datenum(2000,1,1) + ndays)]
pause

end
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Sample Matlab Code to Compute Dates of along Track Data Points

% Sample Matlab code to compute dates of along track data points
% for OSTM collinear data sets
%
clear
% Note that cycle times are given in seconds past 1/1/2000 00:00 GMT
load cycleTimesOSTM.txt

% there are 856711 once-per-second points in a 10-day repeat
point = 700000;
ncycles = size(cycleTimesOSTM,1);
for ncyc=1:ncycles
% calculate how many days past y2000 the time is

ndays = (cycleTimesOSTM(ncyc,2)+point-1)/24/3600;
cycle = cycleTimesOSTM(ncyc,1);
[ 'Cycle #',int2str(cycle), ' Point #' int2str(point) ' '

datestr(datenum(2000,1,1) + ndays)]
pause

end
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Read and Plot Colinear OSTM Data

% read and plot colinear OSTM data
clear
clc
%window version
%datadir = [ 'D:\presentation\data\OSTM\colinear\' ];
datadir = [ '/Users/leben/presentation/data/OSTM/colinear/' ];
filename = [ datadir 'c034.col' ]'
fid = fopen(filename,'r')
ssha = fread(fid,'int32');
% NaN flagged data
iflag = 2^31-1;
ssha(find(ssha==iflag))=NaN;
figure(1)
clf
plot(ssha)

% read OSTM ground track lat lon file - topex_latlon.mat
gtdir = [ '/Users/leben/presentation/groundtracks/' ];
filename = [ gtdir 'topex_latlon.mat' ];
load(filename);
figure(2)
clf
% plot alongtrack data in cm
ssha = (ssha - 205)/10;
ssha(ssha>30)=30;
ssha(ssha<-30)=-30;
plotcol(lon,lat,ssha); colorbar
%h = mesh(x,y,z,c,'LineStyle',['none'],'Marker','o','MarkerSize',[2]);
%h = mesh(x,y,z,c,'LineWidth',[3]);
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Plot Using Pcolor

datadir = ['/Users/leben/presentation/data/avisomerged/tioMat/' ]

% plot using pcolor
figure(1)
clf
subplot(3,1,1)
load ( [ datadir
'dt_ref_global_merged_msla_h_qd_19980107_19980107_20080107.mat'] )
%iflag = ssh(1,1)
iflag = 1.8e+19;
ssh(find(ssh>iflag)) = NaN;
pcolor(lon,lat,ssh);shading flat;colorbar
% overlay coastline
hold on
% load and plot coastline
toolsdir = ['/Users/leben/presentation/tools/'];
filename = [ toolsdir 'global_coastline.mat'];
load (filename)
plot(coastline(:,1),coastline(:,2),'r')
hold on
%axis([ 0 180 -60 60])
id_lat=find(lat==-10);
subplot(3,1,2)
plot(lon,ssh(id_lat,:))
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Plot Bathymetry

% clear workspace
clear
clc
% load and plot bathymetry
% D:\presentation\tools\
toolsdir = ['/Users/leben/presentation/tools/'];
% toolsdir = ['D:\presentation\tools\'];
filename = [ toolsdir 'bath.25.xyz'];
data = load(filename);
lon = data(:,1);
lat = data(:,2);
bath = data(:,3);
ni = 1441;
nj = 489;
bath = flipud(reshape(bath,ni,nj)');
lon = flipud(reshape(lon,ni,nj)');
lon=lon(1,:);
lat = flipud(reshape(lat,ni,nj)');
lat=lat(:,1);
figure(1)
clf
pcolor(lon,lat,bath);shading flat;colorbar
save bath_1_4deg lon lat bath
title('Ocean Depth - Batymetry')
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PLOTCOL

function handle = plotcol(x,y,z,c,linestyle);
% PLOTCOL generates a line plot that uses the color map.
%
% PLOTCOL(X,Y,Z,C,LINESTYLE) plots a colored parametric
% line based on X, Y, Z, and C using the line style
% LINESTYLE. The color scaling is determined by the
% values of C or by the current setting of CAXIS. The
% scaled color values are used as indices into the
% current COLORMAP.
%
% Any combination of inputs can be used. If C is not
% given, it is assigned to Z, Y, or X, depending on the
% input. Below is a table which describes this:
%
% GIVEN VALUE OF C
% X,Y,Z Z
% X,Y Y
% X X
%
% SEE ALSO: mesh

if nargin == 0;error('Requires at least one input');end

% Determine which inputs were given:
if nargin == 1; % 2-D plot, X given.

% Make all inputs into row vectors
x = x(:)';
[m,n] = size(x);
y = [x;x];
x = [1:n;1:n];
z = zeros(2,n);
c = y;

elseif nargin == 2; % 2-D plot, X and Y, C,
%or LINESTYLE are given

x = x(:)';
[m,n] = size(x);
z = zeros(2,n);

if isstr(y) % X and LINESTYLE given.
y = [x;x];
x = [1:n,1:n];

else % X and Y given.
y = y(:)';
y = [y;y];

end

c = y;

elseif nargin == 3; % X, Y, and Z, or
%LINESTYLE given.

x = x(:)';
y = y(:)';
[m,n] = size(x);
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x = [x;x];
y = [y;y];

if ~isstr(z) % X, Y, and Z given
z = z(:)';
z = [z;z];
c = z;

else % X, Y, and LINESTYLE
% given

linestyle = z;
z = zeros(2,n);
c = y;

end

elseif nargin == 4 % X, Y, and Z, C, or
% LINESTYLE given.

x = x(:)';
y = y(:)';
[m,n] = size(x);
x = [x;x];
y = [y;y];

if isstr(c) % 2-D plot with X, Y,
% C, and LINESTYLE

linestyle = c;
c = z;
z = zeros(2,n);

else % 3-D plot with X, Y,
% Z, and C or LINESTYLE

z = z(:)';
c = c(:)';
z = [z;z];
c = [c;c];

end

elseif nargin == 5 % Everything given.
x = x(:)';
y = y(:)';
z = z(:)';
c = c(:)';
[m,n] = size(x);
x = [x;x];
y = [y;y];
z = [z;z];
c = [c;c];

end
h = mesh(x,y,z,c,'LineStyle',['none'],'Marker','o','MarkerSize',[2]);
% h = mesh(x,y,z,c,'LineWidth',[3]);
if all(z == 0), view(2), end

if nargout == 1
handle = h;

end

view(2);
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Sample Filename Loop Over Recon Dataset

% sample filename loop over recon dataset
clear;clc
% loop to load data and calculate mean
datadir = [ '/Users/leben/presentation/data/ReconSeaLevel/'];
n = 0
for iyear = 1951:2008
%for iyear = 1951:1951

for iweek=1:52
n = n + 1
year(n) = iyear + (iweek-1)/52;
if iweek < 10

yr_week = [int2str(iyear) 'wk0' int2str(iweek)]
else

yr_week = [int2str(iyear) 'wk' int2str(iweek)]
end
% filename
filename = [ 'reconsl' yr_week '.mat'];
load([ datadir filename]);
mean_ssh(n) = mean(mean(reconsl(~isnan(reconsl))));

end
end
figure(1);clf
subplot(3,1,1);plot(year,mean_ssh)
subplot(3,1,2);plot(year,mean_ssh);axis([1973 1974 -5 5])
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Make Movie

% make movie of year 1973
clear;clc
% using reconstructed sea levelmovie
datadir = [ '/Users/leben/presentation/data/ReconSeaLevel/'];
figure(1);clf
n=0
for iyear = 1951:1960

for iweek=1:4:52
n = n + 1
year(n) = iyear + (iweek-1)/52;
if iweek < 10

yr_week = [int2str(iyear) 'wk0' int2str(iweek)]
else

yr_week = [int2str(iyear) 'wk' int2str(iweek)]
end
% filename
filename = [ 'reconsl' yr_week '.mat'];
load([ datadir filename]);
pcolor(lon,lat,reconsl);shading flat; colorbar; caxis([-30 30])
text(116,-22,['Year: ' int2str(iyear)])
text(116,-24,['Week #' int2str(iweek)])
title(['\bf CCAR Reconstructed Sea Level'])
M(n) = getframe;

end
end
movie2avi(M,'CCAR_RSL_Movie')
%movie(M)
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Circle

function H=circle(center,radius,NOP,style)
%-----------------------------------------------------------------------
----------------------
% H=CIRCLE(CENTER,RADIUS,NOP,STYLE)
% This routine draws a circle with center defined as
% a vector CENTER, radius as a scaler RADIS. NOP is
% the number of points on the circle. As to STYLE,
% use it the same way as you use the rountine PLOT.
% Since the handle of the object is returned, you
% use routine SET to get the best result.
%
% Usage Examples,
%
% circle([1,3],3,1000,':');
% circle([2,4],2,1000,'--');
%
%-----------------------------------------------------------------------
----------------------

if (nargin <3),
error('Please see help for INPUT DATA.');

elseif (nargin==3)
style='b-';

end;
THETA=linspace(0,2*pi,NOP);
RHO=ones(1,NOP)*radius;
[X,Y] = pol2cart(THETA,RHO);
X=X+center(1);
Y=Y+center(2);
H=plot(X,Y,'color',style);
axis square;

Cycle STR

function [ cycstr ] = cycle_str( cycle )
%CYCLE_STR Adds zero pad to cycle string

if(cycle < 10)
cycstr = [ '00' num2str(cycle) ];

elseif(cycle < 100)
cycstr = [ '0' num2str(cycle) ];

else
cycstr = [ int2str(cycle) ];

end

end
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GetPassThroughROI

function [passStart passEnd passNum] = ...
getPassThroughROI( refLon, refLat, ROIcen, ROIrad, ...

timeStepSample, passPerCycle, ...
plotit )

% [passStart passEnd passNum] =
% getPassThroughROI( refLon, refLat, ROIcen, ROIrad, ...
% timeStepSample, passPerCycle, ...
% plotit )
%
% Function to find passes that go through a cicular region of interest
%
% Inputs:
% refLon = longitude of reference track (must be for a full cycle)
% refLat = lattitude of reference track (must be for a full cycle)
% ROIcen = point of interest [lon lat]
% ROIrad = radius around point of interest to include
% timeStepSample = time step per sample
% passPerCycle = number of passes per cycle
% plotit = plot the result [1] or not [0]
%
% Outputs:
% passStart = array of start times of the passes that enter the ROI
% passEnd = array of end times of the passes that enter/leave the
ROI
% passNum = array of pass numbers that enter the ROI

if( nargin ~= 7 || nargout ~= 3 )
disp( 'Incorrect Usage:' )
disp( ['[passStart passEnd passNum] = ' ...

'getPassThroughROI( refLon, refLat, ROIcen, ROIrad, '...
'timeStepSample, passPerCycle, '...
'plotit'] )

error( 'See above' )
end

samplePerCycle = length( refLon );

refTime = [1:1:samplePerCycle]*timeStepSample;

secondsPerPass = refTime(end) / passPerCycle;

idx = find( (refLon-ROIcen(1)).^2 + (refLat-ROIcen(2)).^2 ...
<= ROIrad^2 );

goodTime = refTime(idx);
goodTimeDiff = diff(goodTime);
goodTimeDiffBk = find( goodTimeDiff > timeStepSample );

if( ~isempty( idx ) )
numPasses = length(goodTimeDiffBk) + 1;

else
numPasses = 0;

end
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goodTimeDiffBk = [0 goodTimeDiffBk length(goodTime)];

passStart = [];
passEnd = [];
passNum = [];

if( plotit ~= 0 )
figId = figure;
plot( refLon, refLat, '.' )
hold on
circle( ROIcen, ROIrad, 1000, 'r' );

end

if( numPasses < 1 )
disp( 'Did not find any passes going through the area of interest' )

else
for ii=1:numPasses

passStart(ii) = goodTime(goodTimeDiffBk(ii)+1);
passEnd(ii) = goodTime(goodTimeDiffBk(ii+1));
passNum(ii) = floor( passStart(ii) / secondsPerPass ) + 1;

if( plotit ~= 0 )
plot( refLon(passStart(ii):passEnd(ii)), ...

refLat(passStart(ii):passEnd(ii)), 'g.');
end

end
end

end
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Plot Tide Guage

clear all

% Include tide guages that have data past this year
year = 2005;

% tide gauge data file
gaugeFile = '../data/TideGauge/indonesiatg_edit.mat';

% Search radius (deg) around tide gauges. This will find reference
ground
% tracks that pass within this distance from each TG.
TGrad = 2;

% Load the reference ground track from ascii (0) or mat file (1)
asciiOrMat = 1;

% Load the reference ground track (deg)
if( asciiOrMat == 0 )

refTrack = '../groundtracks/topex_latlon.ascii';
temp = load( refTrack );

refLon = temp(:,1);
refLat = temp(:,2);

else
refTrack = '../groundtracks/topex_latlon.mat';

temp = load( refTrack );
refLon = temp.lon;
refLat = temp.lat;

end

% Time step per sample of the ref. ground track data
timeStepSample = 1;

% number of passes per cycle
passPerCycle = 254;

% Coastline file
coastFile = 'global_coastline.mat';
load( coastFile )
idx = find( coastline(:,1) < 0 );
coastline(idx,1) = coastline(idx,1)+360;

% ----------------------------------------------------------------------
--
% Load the tide gauges and find which ones have data past the given year
gaugeData = load( gaugeFile );

idx = find( gaugeData.time > year );

temp = ~isnan( gaugeData.sltg(idx,:) );

count = 1;
for ii=1:length(gaugeData.lat)

if( ~isempty( find(temp(:,ii) == 1) ) )
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goodTGData(count) = ii;
count = count + 1;

end
end

% Plot the TG data
figure
plot( gaugeData.time(idx), gaugeData.sltg(idx,goodTGData) )

% Plot the TG locations on the earth
markerList = {'x' '+' '*' 's' 'd' 'v' '^' '<' '>'};

if( length(goodTGData) < 8 )
numColors = 8;

else
numColors = goodTGData + 1;

end

colorList = hsv( numColors );

plotCnt = 1;
plotH = [];
plotM = {};

figId = figure;
plotH(plotCnt) = plot( coastline(:,1), coastline(:,2), ...

'k.', 'markersize', 4 );
plotM{plotCnt} = 'Coastline';
plotCnt = plotCnt + 1;
hold on
grid on

for ii=1:length(goodTGData)
marker = markerList{ mod( plotCnt-2, length(markerList) ) + 1 };

plotH(plotCnt) = plot( gaugeData.lon(goodTGData(ii)), ...
gaugeData.lat(goodTGData(ii)), ...
[marker], 'color', colorList(plotCnt-1,:));

plotM{plotCnt} = ['TG IDX ' num2str(goodTGData(ii))];
plotCnt = plotCnt + 1;

end

% ----------------------------------------------------------------------
--
% Find ref. ground tracks that pass near the TG

totalPassStart = [];
totalPassEnd = [];
totalPassNum = [];

for ii=1:length(goodTGData)

ROIcen = [gaugeData.lon(goodTGData(ii))
gaugeData.lat(goodTGData(ii))];

[passStart passEnd passNum] = ...
getPassThroughROI( refLon, refLat, ROIcen, TGrad, ...

timeStepSample, passPerCycle, ...
0 );



221

totalPassStart = [totalPassStart passStart];
totalPassEnd = [totalPassEnd passEnd];
totalPassNum = [totalPassNum passNum];

circle( ROIcen, TGrad, 1000, ...
colorList(plotCnt+ii-2-length(goodTGData),:) );

end

if( length(totalPassNum) < 8 )
numColors2 = 8;

else
numColors2 = length(totalPassNum) + 1;

end

colorList2 = hsv( numColors2 );

for jj=1:length(totalPassNum)
plotH(plotCnt) = ...

plot( refLon( totalPassStart(jj):totalPassEnd(jj) ), ...
refLat( totalPassStart(jj):totalPassEnd(jj) ), ...
'color', colorList2(jj,:) );

plotM{plotCnt} = ['Pass ' num2str(totalPassNum(jj)) ];
plotCnt = plotCnt + 1;

end

figure( figId )
legend( plotH, plotM )
axis normal
axis( [90 120 -15 15] )
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Plot Track

clear all
%close all

% Load the reference ground track from ascii (0) or mat file (1)
asciiOrMat = 1;

% Start and stop times (assumes the cycle start time is 0)
timeStart = 375000;
timeStop = 395000;

% Seconds per cycle
cycleTime = 856710;

% Start and end cycles to plot
cycleStart = 50;
cycleEnd = 60;

% File with the approximate start cycle times (in time since 1/1/2000)
cycleTimes = 'cycleTimesOSTM.txt';

% Data location
rawDataFolder = '../data/OSTM/raw/';

% Coastline file
coastFile = 'global_coastline.mat';

% Marker size for the plotted data
markersize = 4;

% Load the reference ground track (deg)
if( asciiOrMat == 0 )

refTrack = '../groundtracks/topex_latlon.ascii';
temp = load( refTrack );

refLon = temp(:,1);
refLat = temp(:,2);

else
refTrack = '../groundtracks/topex_latlon.mat';

temp = load( refTrack );
refLon = temp.lon;
refLat = temp.lat;

end

clear temp

% Build the refernce track time (note the ref. track is 1Hz)
refTime = 0:1:cycleTime;

% Trim the refernce track to be within the start and end cycle times
timeIdx = find( refTime >= timeStart & refTime <= timeStop );
refTime = refTime(timeIdx);
refLon = refLon(timeIdx);
refLat = refLat(timeIdx);
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% Load the start cycle times
cycleTime = load( cycleTimes );

% Generate some color map stuff. Remove blue from the mix b/c the
reference
% groundtrack is plotted in blue
if( cycleEnd - cycleStart < 8 )

numColors = 8;
else

numColors = cycleEnd - cycleStart + 1;
end

temp = hsv( numColors + 1);

colorCount = 1;
for count=1:size(temp,1);

if( ~isequal( temp(count,:), [0 0 1] ) )
colorList( colorCount, : ) = temp(count,:);
colorCount = colorCount + 1;

end
end

markerList = {'x' '+' '*' 's' 'd' 'v' '^' '<' '>'};

plotCnt = 1;
plotH = [];
plotM = {};

% load the coastline data
load( coastFile )
idx = find( coastline(:,1) < 0 );
coastline(idx,1) = coastline(idx,1)+360;

% Plot the crude world map and reference track
figId = figure;
plotH(plotCnt) = plot( coastline(:,1), coastline(:,2), ...

'k.', 'markersize', 3 );
plotM{plotCnt} = 'Coastline';
plotCnt = plotCnt + 1;
hold on
grid on

plotH(plotCnt) = plot( refLon, refLat, 'b--o', 'markersize', markersize
);
plotM{plotCnt} = 'Ref Track';
plotCnt = plotCnt + 1;

xlabel( 'Longitude (deg)' )
ylabel( 'Latitude (deg)' )

for cycle=cycleStart:cycleEnd
% format the cycle string
cycleString = ['c' cycle_str(cycle)];

rawCombinedFileName = [ rawDataFolder cycleString '.bin'];

% Get the data for this cycle (note it is little-endian format)
rawFile = fopen(rawCombinedFileName, 'r', 'l' );
data = fread( rawFile, inf, 'int32' );
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fclose( rawFile );

% Note the time stamp of the data is seconds past 1/1/1985
data = reshape( data, 4, length(data)/4 );
time = data(1,:);
lat = data(2,:) / 1e6; % convert mDeg -> deg
lon = data(3,:) / 1e6; % convert mDeg -> deg
ssha = data(4,:) / 10; % convert mm -> cm

% Find the approx start time of this cycle in time since 1/1/2000
% and convert it to time since 1/1/1985
idx = find( cycleTime(:,1) == cycle );

cycleStartTime = cycleTime(idx,2) + 473299200;

% Convert the time data to time past the start of the cycle
time = time - cycleStartTime;

timeIdx = find( time >= timeStart & time <= timeStop );

lat = lat( timeIdx );
lon = lon( timeIdx );
ssha = ssha( timeIdx );

marker = markerList{ mod( plotCnt-2, length(markerList) ) + 1 };

figure( figId )
plotH(plotCnt) = plot( lon, lat, [marker], ...

'markersize', markersize, ...
'color', colorList(plotCnt-2,:) );

plotM{plotCnt} = ['Cycle ' num2str(cycle)];
plotCnt = plotCnt + 1;

end

figure( figId )
legend( plotH, plotM )

% save the figure temporarily so we can load another copy
saveas( figId, 'temp.fig' );
open( 'temp.fig' )
axis( [89.6549 89.7651 0.6643 0.980] )
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Ground Tracks

(Get Latitude Longitude)

clear all

tol = eps;

sat = 'nvs';

%fid = fopen( [sat '.latlon'], 'r', 'b' );
%data = fread(fid, inf, 'int32');
%fclose(fid);

%data = reshape( data, 2, length(data)/2 );

%lon = data(2,:)' / 1e6;
%lat = data(1,:)' / 1e6;

%-------------------------------------------
fid = fopen( [sat '.lon'], 'r', 'b' );
lon2 = fread(fid, inf, 'int32');
fclose(fid);

fid = fopen( [sat '.lat'], 'r', 'b' );
lat2 = fread(fid, inf, 'int32');
fclose(fid);

lon2 = lon2 / 1e6;
lat2 = lat2 / 1e6;

lon = lon2;
lat = lat2;

if( ~isempty( find( lat ~= lat2, 1 ) ) )
disp( 'Lats diff' )

end

if( ~isempty( find( lon ~= lon2, 1 ) ) )
disp( 'Lons diff' )

end

% Write out to ascii

data = [lon lat];
fid = fopen( [sat '_latlon.ascii'], 'w+' );

fprintf( fid, '%.8e %.8e\n', data' );
fclose(fid);

% Write out to mat
save( [sat '_latlon.mat'], 'lat', 'lon', '-v7.3' )

% ---------------- CHECK
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origLat = lat;
origLon = lon;

load( [sat '_latlon.mat'] )

if( ~isempty( find( origLat ~= lat, 1 ) ) )
disp( 'MAT Lats diff' )

end

if( ~isempty( find( origLon ~= lon, 1 ) ) )
disp( 'MAT Lons diff' )

end

data = load( [sat '_latlon.ascii'] );
lon2 = data(:,1);
lat2 = data(:,2);

if( ~isempty( find( abs( origLat - lat2 ) > tol, 1 ) ) )
disp( 'ASCII Lats diff' )

end

if( ~isempty( find( abs( origLon - lon2 ) > tol, 1 ) ) )
disp( 'ASCII Lons diff' )

end

% -------------
figure
plot(origLon,origLat,'.')
hold on
plot(lon,lat,'ro')
plot(lon2, lat2, 'g+')

return
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EOF Analysis

clear; clc
load sealeveldata
%insert data - should be a lat x lon x time matrix
data = sldata;

errval = 998;
%Data Processing
I = [];
J = [];
timedim = 76;
data2 = zeros(64000,timedim);
obvmat = zeros(64000,timedim);
k = 1;

for i = 1:360
for j = 1:180

datawin = data(i,j,:);
m = find((datawin) ~= errval);

if length(m) > timedim/2
I = [I;i];
J = [J;j];
d = reshape(datawin,timedim,1);
obvmat(k,:) = d;
k = k+1;

end
end

end

m = find(obvmat(:,1) == 0);
obvmat = obvmat(1:m(2)-1,:);

x = 1:timedim;

data3 = zeros(size(obvmat,1),timedim);
for i = 1:size(obvmat,1)

c2 = obvmat(i,:);
m1 = find(c2 == errval);
m2 = find(c2 ~= errval);
c2(m1) = interp1(x(m2),c2(m2),x(m1),'linear','extrap');
data3(i,:) = c2;

end

%Center Data
H = eye(size(x',1)) -
(1/(size(x',1))*(ones(size(x',1),1))*(ones(size(x',1),1))');

HQ = H*data3';

[U,S,V] = svd(HQ,'econ');

V1 = V*S;

for i = 1:size(V,2)
Vmean(i) = nanmean(V1(:,i));
end
%Form temporal EOFs with physical units
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for j = 1:size(U)
Udata(:,j) = U(:,j)*Vmean(j);

end

Vmap = zeros(360,180);

%Reconstruct map, n corresponds to EOF #
n = 1;

for i = 1:size(obvmat,1)
Vmap(I(i),J(i)) = V1(i,n)/mean(Vmean(n));

end

m = find(Vmap == 0);
Vmap(m) = NaN;
pcolor(lon,lat,Vmap')
title('EOF #1')
colorbar

shading interp

%Percent variance in each mode
Sperc = 100*diag(S).^2/sum(diag(S).^2);
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Indian Oocean Dipole

1. calcIODipole

clear all

% calculate the indian ocean dipole mode index. DMI is the mean of the
% ssh in ROI1 minus the mean of the ssh in ROI2.

% Box 1, deg E and N
ROI1 = [50 70 -10 10];
ROI2 = [90 110 -10 0];

% bathymetry file and depth to trim
bathFile = '../../tools/bath.5.grd';
bathDepth = 500; % meters

% Flagged value and comparison tolerance
flagged = double( intmax('uint64') );
tolerance = 1;

% load the bath data and generate to sets covering the regions of
interest
fid = netcdf.open( bathFile, 'noclobber' );

bathLon = netcdf.getVar( fid, 0 );
bathLat = netcdf.getVar( fid, 1 );
bathData = double(netcdf.getVar( fid, 2 ));

bathData( bathData < bathDepth ) = NaN;
bathData( bathData >= bathDepth ) = 1;

% Region 1
idxLon = find( bathLon >= ROI1(1) & bathLon <= ROI1(2) );
idxLat = find( bathLat >= ROI1(3) & bathLat <= ROI1(4) );

bathLon1 = bathLon( idxLon );
bathLat1 = bathLat( idxLat );
bathData1 = bathData( idxLon, idxLat )';

% Region 2
idxLon = find( bathLon >= ROI2(1) & bathLon <= ROI2(2) );
idxLat = find( bathLat >= ROI2(3) & bathLat <= ROI2(4) );

bathLon2 = bathLon( idxLon );
bathLat2 = bathLat( idxLat );
bathData2 = bathData( idxLon, idxLat )';

% ----------------------------------------------------------------------
--
n=0
fileList = dir( pwd );

for fileCount=1:length(fileList)
% Find only files with .nc extension
if( fileList(fileCount).isdir ~= 1 ...

&& ~isempty( strfind( fileList(fileCount).name, '.mat' )) )
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clear lat lon reconsl
load( fileList( fileCount ).name );

% Get box 1
idxLon = find( lon >= ROI1(1) & lon <= ROI1(2) );
idxLat = find( lat >= ROI1(3) & lat <= ROI1(4) );

r1Lon = lon( idxLon );
r1Lat = lat( idxLat );
r1Ssh = reconsl( idxLat, idxLon );

r1Ssh = r1Ssh .* bathData1;

% Get box 2
idxLon = find( lon >= ROI2(1) & lon <= ROI2(2) );
idxLat = find( lat >= ROI2(3) & lat <= ROI2(4) );

r2Lon = lon( idxLon );
r2Lat = lat( idxLat );
r2Ssh = reconsl( idxLat, idxLon );

r2Ssh = r2Ssh .* bathData2;

if( 0 )
figure
pcolor( r1Lon, r1Lat, r1Ssh )
shading flat
colorbar
hold on
pcolor( r2Lon, r2Lat, r2Ssh )
shading flat
axis( [40 110 -15 15] )

end

% Find the average ssh in each box after removing flagged and
NaN

% data
if( ~isempty( find( abs( r1Ssh - flagged ) < tolerance, 1 ) ) ||

...
~isempty( find( abs( r2Ssh - flagged ) < tolerance, 1 ) ) )
disp( ' ' )
disp( 'Flagged data in:' )
disp( fileList( fileCount ).name )

end

r1Ssh = reshape( r1Ssh, size(r1Ssh,1)*size(r1Ssh,2), 1 );
r1Ssh = r1Ssh( abs( r1Ssh - flagged ) > tolerance );
r1Ssh = r1Ssh( isnan( r1Ssh ) ~= 1 );
r1Mean = mean(r1Ssh);

r2Ssh = reshape( r2Ssh, size(r2Ssh,1)*size(r2Ssh,2), 1 );
r2Ssh = r2Ssh( abs( r2Ssh - flagged ) > tolerance );
r2Ssh = r2Ssh( isnan( r2Ssh ) ~= 1 );
r2Mean = mean(r2Ssh);

DMI = r1Mean-r2Mean;
n=n+1

dmi(n) = DMI;
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year(n) = 1950+(n +27-1)/52;

disp( ' ' )
disp( fileList( fileCount ).name )
disp( ['R1:R2:DMI ' num2str(r1Mean) ' : ' num2str(r2Mean) ...

' : ' num2str(DMI)] )

% save( fileList( fileCount ).name, 'lat', 'lon', 'reconsl',
'DMI' );

end
end
save IOD dmi year
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2. Plot IOD

clear
load IOD
figure(1)
clf
subplot(3,1,1)
plot(year,dmi,'LineWidth',[2])
title('\bf Raw dipole region differences')
% now remove climatological mean
% trim points before 1951
id = find(year==1951);
start = id(end)
id = find(year==2009);
stop = id(1)
year= year(start:stop-1);
dmi = dmi(start:stop-1);
dmi = reshape(dmi,52,58);
dmi_clim = mean(dmi');
subplot(3,1,2)
plot(dmi_clim,'LineWidth',[2])
axis tight
title('\bf Weekly Climatological Values (1951-2008)')

% remove climatological values from dmi
for i=1:58

for iweek=1:52
dmi(iweek,i) = dmi(iweek,i)-dmi_clim(iweek);
end

end
subplot(3,1,3)
dmi = reshape(dmi,58*52,1);
plot(year,dmi,'LineWidth',[2])
title('\bf Dipole Mode Index (DMI)')
orient 'landscape'
print -depsc2 bobo1
figure(2)
subplot(2,1,1)
dmi = reshape(dmi,58*52,1);
plot(year,dmi,'LineWidth',[2])
grid on
title('\bf Dipole Mode Index (DMI)')
print -depsc2 bobo2
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